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Foreword to the First Edition

xxv

IT’S A SMALL CELEBRATION for me to write this foreword—almost exactly
two years after the first meeting of a small group of free software profes-
sionals that turned into the Ubuntu project. A celebration because two
years ago none of us would have predicted that our dream would spawn
several million CDs, three or four million enthusiastic users, hundreds of
commitments of support from companies large and small, a minor prime
time television reference, and now The Official Ubuntu Book.

The dream that brought us together can be simply expressed:

To build a world-class operating system for ordinary desktop computer
users, that is genuinely free and freely available, that is immediately useful,
and that represents the very best that the free software world can achieve
today.

In setting out to build a platform for “ordinary desktop computer users,” I
had no idea that I would have the privilege of meeting and working with
so many extraordinary desktop computer users. Some of those extraordi-
nary individuals are the authors of this book, people who both understand
the importance of the free software movement and have the talent to have
been real contributors to its success. Others make up the backbone of the
Ubuntu community—the small but dedicated army of a few hundred
people that works to produce a new release of Ubuntu every six months.
They are at the heart of a network that reaches out through the global free
software community—through the world of Debian, an extraordinary
project in its own right and without which Ubuntu could not exist, and on
out to the thousands of projects, large and small, that produce the code
and documentation that we pull together and call Ubuntu.

While this huge extended community can often appear to be fractured and
divided along infinitesimal ideological lines, we are all broadly in agreement



about four key ideas, and it is those ideas that are central to the Ubuntu
promise:

� That our software should not come with a license fee. That we should
be able to share our software, modify it, and then share our modifica-
tions, too.

� That this free software should be the best version available, including
regular security updates, and not a tease for a better, commercial
product.

� That full-scale, high-quality commercial support from local and
global companies should be available for this free platform.

� That this software should be usable in as many languages as possible
and usable by as many people as possible regardless of disability.

The 17 of us who met in London two years ago come from a very wide
variety of countries and backgrounds, but we all agreed that the goal of
producing a platform that could live up to that promise was a worthy one,
one that we would devote ourselves to wholeheartedly.

For several months we worked quietly. We wanted to come to the world not
only with a manifesto but also with a clear demonstration of work done
toward our goals, something that people could test and comment on. We
had no name (though industry insiders called us the “Super-Secret Debian
Startup”), and, as a result, we hosted most of our work at www.no-name-
yet.com. We were looking for a name that could express the beauty of the
free software community development process—collaboration, interde-
pendence, sharing, standing gently on the shoulders of giants, and reaching
for lofty goals. The only word that comes close to that, of which I’m aware,
is the African word ubuntu. It is found in many forms in many different
African languages. And so we adopted it as the name of our project. 

We knew that our first release would have blemishes—warts—and gave it
the codename “The Warty Warthog.” We called ourselves “the warthogs”
and coordinated our work on the #warthogs IRC channel. Today, for bet-
ter or worse, that’s turned into a tradition of codenames such as “Breezy
Badger” and “Dapper Drake.” As lighthearted as they sound, these code-
names come to embody the spirit of our community as it works toward a
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particular release. This next one—Dapper—is exactly that: a man emerg-
ing from youth, professional, bold, confident, and energetic. This is our
first release that is designed to meet the needs of large organizations as
much as developers and engineers. In the same way, the Ubuntu commu-
nity has moved from being something of a rebellion against the “Linux
establishment” to a strong and professionally organized group.

What Makes Ubuntu So Popular?
First, this is the time for free software to come to the forefront, and
Ubuntu is very much the beneficiary of the vast amount of work that has
gone into building up a huge body of work in the GNU/Linux world. That
work has been underway for nearly 30 years, in one form or another, but
Ubuntu is one way in which it is suddenly becoming “visible” to the non-
specialist computer user. We are in the middle of a great overturning of the
industry status quo. The last time that happened, in the mid-1990s, was
when the world suddenly found itself connected to itself—by the Internet.
Every major company, especially those in the field of technology, had to
examine itself and ask the question, “How do we adapt to an Internet
world?” Today, every major technology company has to ask itself the ques-
tion, “How do we adapt to a free software world?”

I would speculate and say that Ubuntu represents an idea whose time has
come. We did not invent the free software movement—that honor goes to
Richard Stallman and many others who had a vision far more profound at a
time when it was hard to see how it could ever become reality. But Ubuntu
has perhaps the honor of bringing that vision to a very wide audience in a
form that we can all appreciate. I hope that the real visionaries—those who
have led the way—will appreciate the decisions and the choices we make in
bringing you this project. Some will take exception—I know Linus prefers
KDE to GNOME, for example, so he’s likely to be more of a fan of Kubuntu
than Ubuntu. But in general, the ideas that others have had, the principles
of the free software movement, are well expressed in Ubuntu.

Second, Ubuntu is a project on which you can have a real impact. It has the
benefit of deep and reliable financial backing and a corporate team to give
it muscle, but it is in every regard an open project, with participation at the
highest levels by true volunteers. We work in a fishbowl—our meetings take
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place online, in a public forum. That can be tricky. Building an operating
system is a fast-paced business full of compromise and tough decisions in
the face of little information. There are disagreements and dirty laundry,
and mistakes are made. (I should know; some of them are mine. You should
hear the one about the Warty Warthog desktop artwork.) The transparency
of our environment, however, means that we can count on having robust
conversations about our options—all of them, even the ones the core team
would never have dreamed up. It also means that mistakes are identified,
discussed, and ultimately addressed faster than they would be if we lived
and worked behind closed doors. You get a better platform as a result.

We work hard as a community to recognize the contributions of all sorts
of individuals—advocates, artists, Web forum moderators, channel opera-
tors, community event organizers, writers, translators, people who file and
triage bugs . . . whatever your particular interest or talent, we will find a
way to integrate your contribution.

Perhaps most important is the way our approach to community differenti-
ates Ubuntu from other free software projects with similar vision. We try to
do all of this in a way that recognizes that disagreements are important but
prevents those disagreements from creating deep divides in our commu-
nity. Our code of conduct may not be perfect, but it reminds each of us to
remember the meaning of the word ubuntu—that each of us has our best
impact through the relationships we maintain with one another. Finding
common ground and maintaining healthy communication are more
important for us as a community in the long run than a particular technical
decision or the specific choice of words with which to translate “File” into
Spanish. Our community governance structures—our Technical Board
and Community Council—exist to ensure that debates don’t become per-
sonal and that decisions can be taken after all sides have been heard.

If you are a software professional or curious about Linux, this book and this
platform are an excellent choice. You will learn about the world of Ubuntu
and, indirectly, Debian and GNU/Linux. These are great foundations for
working with the tools that I believe will come to define the “standard,” the
everyday computing base upon which we build our homes and offices.

I once heard a proprietary software vendor say, “Linux is more expensive
because skilled Linux professionals are more costly.” This is true. It means,
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of course, that Linux skills are more valuable! It won’t be true forever
because the world of Linux is expanding so rapidly that sooner or later we
will have to accept a position in the mainstream, and that takes off some of
the “geek points” associated with being part of the “future of technology.”
But right now, without a doubt, being ahead of the curve on Linux and on
Ubuntu is the right place to be. If you’re this far into this foreword, you are
clearly going to make it. ;-) 

It’s difficult for me to speculate on what the future might hold for the
Ubuntu project. I know that I along with many others are loving the
opportunity to be at the center of such an exciting initiative and are com-
mitted to seeing where it leads us over the coming years. I believe that it
will become a pervasive part of our everyday computing environment, so I
would like to help make sure that we don’t make too many mistakes along
the way! Please, come and join us in the fishbowl to help ensure we do a
very, very good job.

—Mark Shuttleworth
Ubuntu Founder

April 2006
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Preface

xxxi

AS WE WRITE THIS, it is two years since we penned the first edition of The
Official Ubuntu Book and a year since the second. The last year has seen
Ubuntu continue its explosive growth. Updating this book drives this fact
home in striking ways. For example, the number of users and posts have
nearly doubled since the last edition of this book a year ago. Again. The
number of officially supported flavors of Ubuntu have been added to.
Again. Once again, we feel blessed that The Official Ubuntu Book has been
able to benefit from, and perhaps in a small way even contribute to, that
success. Ultimately, that success paved the way for the second and now the
third edition of the book that you’re reading now.

In the process, this book, like Ubuntu, is beginning to mature. Like
Ubuntu, we have now put together our piece a few times and are begin-
ning to get more comfortable. Our job as authors, like that of the Ubuntu
developers, now involves more updating and polishing than it used to.
Distributed under a free license, a once-risky book on a once-risky operat-
ing system is, just two short years later, as close to a sure thing as an author,
publisher, and if we have done our job well, a reader, could hope for.

And yet with success comes responsibility to our readers and to our users
with high expectations. Ubuntu’s success is built in part of maturity and
excellence, and it cannot sacrifice these qualities if it will succeed. We can-
not either. Our job as writers is complicated because we need to accurately
reflect and represent both while catering to an increasing and increasingly
diverse group of users.

As we’ve noted in the prefaces to previous editions of this book, being
Official has carried with it a set of rights and responsibilities. Our book’s
title means that we must attempt to reflect and represent the whole
Ubuntu community. While we, as authors, are expected to put ourselves



xxxii Preface

into the book, it is understood that it can never be to the detriment of the
values, principles, technologies, or structures of the Ubuntu community.

Doing this has been complicated as Ubuntu has grown. In the second edi-
tion, we added a chapter on Edubuntu, which is updated in this edition
because the Ubuntu community has grown to include this new project. In
each revision of this book, we have needed to add to the list of related
projects, tools, and community initiatives. As the Ubuntu community
grows, it is impossible to give a complete accounting of what Ubuntu has
to offer. Creating a summary requires some hard decisions. At the end of
the day, we are constrained by page count and our own limited schedules.

Meanwhile, as with the first and second editions, we needed to write this
book about a new release of Ubuntu while that version was under active
development and was being redesigned, rethought, and rebuilt. Every day,
Ubuntu grows in different, unpredictable ways, and this growth has
increased exponentially with the size of the community and the diversity of
the userbase. Our book’s development process had to both match and track
this process as our content was crafted, rewritten, adjusted, and allowed to
mature itself.

As in the previous edition, the contributors to this book go well beyond
those listed on the book’s cover. As in the first two editions, the recipes
included in Chapter 6 have been elicited from and designed in consulta-
tion with the community. But while the community contributions are
sometimes less visible in other chapters, they are no less present. Invisible
to most readers, dozens of members of the community left their mark on
different parts of the text of this book. Although this degree of participa-
tion led to a writing process that was as hectic, and at times frustrating, as
the process that builds Ubuntu, we hope we can remind readers of the
level of quality that this process inspires in our book’s subject. In the places
where we achieve this, we have earned our book’s title. With that goal in
mind, we look forward to future versions of Ubuntu and editions of this
book wrought through the same community-driven process.
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WELCOME to The Official Ubuntu Book, Third Edition!

In recent years, the Ubuntu operating system has taken the open source
and IT world by storm. From out of nowhere, the Little Operating System
That Could has blossomed into a full-featured desktop and server offering
that has won over the hearts of users around the world. Aside from the
strong technical platform and impressive commitment to quality, Ubuntu
also enjoys success because of its sprawling community of enthusiastic
users who have helped to support, document, and test every millimeter of
the Ubuntu landscape.

In your hands you are holding the official, authorized guide to this impres-
sive operating system. Each of the authors selected to work on this book
has demonstrated a high level of technical competence, an unbridled com-
mitment to Ubuntu, and the ability to share this knowledge in a simple
and clear manner. These authors gathered together to create a book that
offers a solid grounding to Ubuntu and explains how the many facets and
features of Ubuntu work.

About This Book
At the start of every book, on every bookshelf, in every shop, is a para-
graph that sums up the intentions and aims for the book. We have one
very simple, down-to-earth aim: to make the Ubuntu experience even
more pleasant for users. The Ubuntu developers and community have
gone to great lengths to produce an easy-to-use, functional, and flexible
operating system for doing, browsing, and creating all kinds of interesting
things. This book augments that effort. With such an integrated and flex-
ible operating system, this guide acts as a tour de force for the many things
you can do with Ubuntu.



The Scope of the Book
With so much to cover, we had our work cut out to write a book that could
cover the system in sufficient detail. However, if we were to write in detail
about every possible feature in Ubuntu, you would need to buy a new
bookcase to store the sheer amount of content.

Part of the challenge in creating The Official Ubuntu Book was selecting
the topics and content that can be covered within a reasonably sized book.
As such, we have identified the most essential content to be covered and
written about it. These chosen topics not only include coverage of installa-
tion, use of the desktop, applications, multimedia, system administration,
and software management but also include a discussion of the commu-
nity, online resources, and the philosophy woven into Ubuntu and open
source. In addition, we managed to squeeze in a chapter full of useful trou-
bleshooting recipes that you can use when you need to troubleshoot prob-
lems. All in all, the book provides an ideal one-stop shop for getting
started with Ubuntu.

The Menu
Let’s take a look at the range of chapters included in the book and what
each covers.

� Chapter 1—Introducing Ubuntu: This spirited introduction
describes the Ubuntu project, its distribution, its development
processes, and some of the history that made it all possible.

� Chapter 2—Installing Ubuntu: Run through the installation process
one step at a time, and get Ubuntu ready to run on your computer.

� Chapter 3—Using Ubuntu on the Desktop: Take a whistle-stop tour
of the Ubuntu desktop and the applications included, and explore
ways to configure your desktop.

� Chapter 4—Advanced Usage and Managing Ubuntu: Explore some of
the advanced ways to use Ubuntu, including managing the system.
Learn how to install and manage software, use hardware devices and
printers, interact with remote computers, use the terminal, and run
some Windows programs under Ubuntu. 
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� Chapter 5—The Ubuntu Server: This introduction to Ubuntu Server
installation and administration includes coverage of console-line
package management, basic security topics, and advanced installer
features such as logical volume management and RAID.

� Chapter 6—Support and Typical Problems: Packed to the seams with
lots of small, independent recipes, this chapter teaches you how to
solve common problems or meet requirements.

� Chapter 7—The Ubuntu Community: Understand the breadth of the
Ubuntu community, including what folks do to build, promote,
distribute, support, document, translate, and advocate Ubuntu—and
find out what you can do to join in the fun.

� Chapter 8—Using Kubuntu: The most popular spin-off project from
Ubuntu is Kubuntu. This chapter provides a solid primer for getting
started.

� Chapter 9—Using Edubuntu: Read in-depth coverage of the
Edubuntu distribution and community for educators.

� Chapter 10—Ubuntu-Related Projects: Explore the universe of other
distributions that surround Ubuntu, including Xubuntu, Gobuntu,
Ubuntu Studio, Launchpad, and Bazaar.

� Appendix A—Welcome to the Command Line: Take advantage of the
power of the command line with clear, easy-to-use examples in this
brief primer.

� Appendix B—Ubuntu Foundation Documents: Review some of the
key documents that define Ubuntu, including the Code of Conduct,
the Ubuntu Licensing Policy, the Leadership Code of Conduct, the
Ubuntu Philosophy, and the Description of Ubuntu Components.

� Appendix C—Creative Commons Attribution-ShareAlike 3.0 Open
Publication License.

� Appendix D—Ubuntu Equivalents to Windows Programs.

The Ubuntu team offers several installation options for Ubuntu users,
including CDs for desktop, alternate install, and server install. These three
CD images are conveniently combined onto one DVD included in the back
of this book, allowing you to install Ubuntu for different configurations
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from just one disk. There is also an option to test the DVD for defects as
well as a memory test option to check your computer.

The first boot option on the DVD, Start or Install Ubuntu, will cover most
users’ needs. For more comprehensive information, check the Help feature
by selecting F1 on the boot menu. You can also refer to Chapter 2, which
covers the Ubuntu installation process in detail.

You can find the DVD image, the individual CD images (for those who
don’t have a DVD drive), and Kubuntu and Edubuntu images on www.
ubuntu.com/download. 
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Using Ubuntu on the Desktop



WITH UBUNTU INSTALLED and ready to go, it’s time to get started using your
new desktop. The stock install of Ubuntu provides a very complete and
flexible system. Unlike other operating systems, Microsoft Windows for
example, Ubuntu includes everything you need to get started, such as an
office suite, media tools, a Web browser, a graphics package, an e-mail
client, and more. With the installation complete, you are up and running
right away.

Using a computer is a rather individual process, and different people use
their computers in different ways. To help promote this choice, Linux has
the capability to use any one of a number of different graphical interfaces.
This flexibility, combined with the ballooning popularity of Linux and
open source, has resulted in literally hundreds of different graphical envi-
ronments springing up, each covering these different types of users and
ways of working.

Despite this huge range of different environments available, there are two
clear leaders in KDE and GNOME. Both environments provide a com-
prehensive and easy-to-use desktop, but they differ in how that desktop is
used. The KDE system is more akin to Windows and aims for complete
configurability of your desktop. The competing GNOME desktop shows
inspiration from both Windows and Mac OS X and sets as a priority sim-
plicity and ease of use. Luckily, Ubuntu users are blessed with the choice
of either desktop—the default desktop in stock Ubuntu is GNOME, and
the Kubuntu distribution uses the KDE desktop. Kubuntu is covered in
Chapter 8.

In this chapter, you get started with GNOME and use it to do the normal
and not-so-normal things you face every day with your computer. This
includes opening and running applications, managing your files, adjusting
the look and feel, using applications, managing your media, and more.
Buckle up and get ready to take your shiny new desktop for a drive!

TIP The Ubuntu Desktop Is GNOME
When reading about Ubuntu, you often see the terms Ubuntu desktop and GNOME used
interchangeably. Both of these terms refer to the same thing—the default Ubuntu desktop is
a version of GNOME itself. Of course, Ubuntu provides several other desktops, including
KDE (in Kubuntu), Xfce (in Xubuntu), and a variety of others.
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Taking Your Desktop for a Ride
When you start your Ubuntu system, you are asked for a username and
password to log in with. In the last chapter you specified a user account
when installing the system, so use that to log in. First type in your user-
name and press Enter, then your password and press Enter.

TIP Language? Sprache? Langue? Lingua?
Click the Options > Select Language button to change the language of the desktop. If you
click the button and the selection does not include your language, jump to the Ubuntu in
Your Language section on page 102 to learn how to add new language packs. 

After a few seconds you will see the Ubuntu desktop appear (Figure 3-1).
The desktop comprises three main areas.

1. At the top of the screen is the panel. This bar contains the desktop
menu options and application shortcut icons on the left side as well 
as the notification area on the right side. You use this bar to load
applications and to see the status of certain activities on your system.
The panel is always visible when you use your desktop.
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Figure 3-1 The Ubuntu desktop is simple, uncluttered, and . . . brown.



2. The large middle part of the screen is the desktop. This part of the
screen is normally covered by the applications that you use, but you
can also put icons and shortcuts on the desktop, too.

3. The bottom part of the screen is called the taskbar. This area displays
a rectangle for each open application, just like in Windows.

You may have noticed that, unlike other operating systems, there are no
icons on the desktop. The reason for this is that desktop icons typically get
covered by applications, and, as such, you can’t get at them. If you need to
start applications, you typically use the Applications menu or the shortcuts.

TIP Device Icons
Although there are no application icons on the desktop, when you plug in USB devices such
as portable music players, keyring drives, or digital cameras, a device icon will appear on the
desktop.

Starting Applications and Finding Things
Starting applications is simple. Just click on the Applications menu on the
left side of the panel. Inside this menu are a number of submenus for dif-
ferent types of applications. Hover your mouse over each category, and
then click the application you want to load. As an example, click on Appli-
cations > Internet > Firefox Web Browser. After a few seconds the browser
will pop up.

When applications are loaded, the brown window border has three but-
tons on the right-hand side:

� Left button (thin white line): This is used to minimize the applica-
tion and put it in the taskbar.

� Middle button (white square): This maximizes the window to take
up the full desktop area.

� Right button (white cross): This button closes the application.

Every application has an entry in the taskbar at the bottom of the screen.
You can click these entries to minimize or maximize the application and
right-click to see some other options.
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Changing Your Menu Layout Although the main Applications, Places,
and System menus are logical by default, you may want to further cus-
tomize them by moving entries into different submenus, not displaying
certain items, and making other tweaks. All of this is easily done with the
built-in menu editor.

To edit the menus, right-click on a menu, and select Edit Menus. The menu
editor now appears, as shown in Figure 3-2.

The menu editor is fairly intuitive. To adjust which items are shown, click
on a submenu in the left-hand pane and change the Show checkbox for the
items you want to show or hide. To add a new item, select the submenu the
item should appear in, and then click the New Item button on the right-
hand side. The box shown in Figure 3-3 will appear.

Menu items can be applications (the default), applications running in ter-
minals, or files. Select the appropriate setting for the Type box for your
menu item, or leave it as Application. Provide a name for your menu item
in the Name box, the command to run in the Command box (or the loca-

Taking Your Desktop for a Ride 61

Figure 3-2 The menu editor lets you easily change the Ubuntu menus.



tion of your file in the Location box if you changed the type to File), and a
brief description in the Comment box. You can also use the Browse button
to select the application to run (or the file to open). Finally, click the
default icon off to the side, and select an icon for the item. Click OK to fin-
ish adding the new menu item.

Finding Your Files and Folders
When using your computer, you often need to save and open files and
folders, move them around, and perform other tasks. The Places menu
contains a bunch of entries, including those listed here, to access different
parts of your computer and the network. 

� Home Folder: Your home folder is used to store the files and work for
each user who is logged in. This is the most important folder on the
system, and you can think of it as the equivalent of My Documents in
Windows—virtually everything you save lives here. Each user has a
separate home folder.

� Desktop: The Desktop folder is inside your home folder and contains
files that visually appear on your desktop as icons. If you drag a file
onto your desktop, it will appear in the Desktop folder. Similarly,
moving a file out of this folder or deleting it will remove it from your
desktop.

� Computer: Clicking this item displays the different drives attached to
your computer as floppy drives, CD/DVD drives, and USB keys or
sticks. This is the equivalent of the My Computer icon in Windows.
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� Network: This option accesses servers that are available on your local
network. This is the equivalent of the Network Neighborhood in
Windows.

� Connect to Server: Click this to run a wizard to create a connection
to a network server. You can use this to add an icon to the desktop
that, when clicked, provides a list of remote files in the desktop file
manager. You can then treat this window like any other file manager
window and drag files back and forth. This is really useful for copying
files to other computers.

� Search for Files: Use this to search for files on your computer.

� Recent Documents: Click this submenu to display the most recently
used documents.

Configuring Your System
The third and final menu, System, is used to configure and customize your
system, access help, and report problems. Inside the menu are a few options,
including these.

� Preferences: This submenu contains items for customizing the look
and feel of your desktop. Each of these settings applies only to the
desktop of a user who is logged in. If you log in as another user, the
settings change to that user’s preferences.

� Administration: This submenu is used to configure systemwide
settings such as networking, users, printing, and more. To use these
menu items, you need to know the system administrator password.

� Help and Support: With this you can access the Ubuntu Help Center,
which provides documentation and guides for your Ubuntu desktop.

TIP Feel the Power
When you installed Ubuntu, you were asked for a username and password for the system.
This password not only provides access to your normal user account but also accesses the
all-powerful Administration features. As such, when you access the menu options and are
asked for the password, just enter your normal password, and you can use those features.

This feature applies only to the first user account that you created on the system. If you add
other accounts, those users cannot access the Administration options unless you explicitly
give them access.
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Shortcut Icons
On the panel are a number of shortcut icons next to the menus. These
small icons are always visible and can be single-clicked to gain immediate
access to your favorite applications. Ubuntu comes with several stock
shortcuts on the panel, but you are welcome to add your own.

Adding your own icon is as simple as finding the application you want to
add in the menu and then dragging it to the panel. You can then right-click
the new shortcut icon and select Move to move it to the right place.

Applets
One simple yet powerful feature in Ubuntu is the ability to run small pro-
grams called applets on the panel. These small programs are useful for a
variety of tasks and provide quick and easy access via the panel.

To add an applet, right-click the panel and select Add to Panel. The win-
dow shown in Figure 3-4 pops up. Select one of the many applets, and click
Add. When the applet appears on the panel, you can press the middle
mouse button (or the left and right buttons together) to move it around.
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The Notification Area
In the top right-hand part of the panel is the notification area and the
clock. The notification area is similar to the Windows system tray in that it
provides a series of small icons that indicate something specific. A good
example of this is Network Manager, which looks after your network con-
nections—both wired and wireless—for you.

You can fiddle with the notification area items by right-clicking them to
view a context menu. Some icons (such as the volume control) allow you
to left-click on them to view them. As an example, try clicking the little
speaker icon and adjusting the slider.

QUICK TIP Right-click the volume icon and select Open Volume Control to access the mixer settings for
your sound card. These settings configure the speakers, microphone, line-in, and any other
sound card inputs or outputs.

The Clock
Next to the notification area is the clock. Click on the clock to view a cal-
endar. Later, when you use Evolution, items that are added to your calen-
dar appear in the clock applet too. Instead of opening up Evolution to
find out when your dentist appointment is, just click on the clock to see it
immediately.

QUICK TIP Customize your clock by right-clicking it and selecting Preferences.

The Taskbar
The taskbar sits at the bottom of the screen. This small bar is always visible
and indicates which applications are currently open. In addition to this,
the taskbar also sneaks in a few other handy little features.

To the far left of the taskbar is the Hide/Show Desktop button. Clicking
this button hides all of your open applications and shows the desktop.
Clicking it again redisplays them. This button is useful when you need to
quickly access something on your desktop.
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Next to this button is the applications area, which shows each of the cur-
rently open applications. For each application, an entry is added, and you
can right-click it to view a context menu. This menu can also be used to
minimize, maximize, resize, close, and otherwise control applications.

QUICK TIP You can switch between multiple applications in Ubuntu just like in Windows by pressing
Alt-Tab. When you press this key combination, a small window appears that can be used to
switch between active applications.

To the right of the applications area are two small rectangles called the work-
spaces. Each of these rectangles represents another screen in which you can
view an application. As an example, you may be using your Web browser
and e-mail client while talking to your friends in a chat client on the first
desktop and working on a document on the second desktop. You can then
just click each virtual desktop to switch to it to access your different applica-
tions. Another useful tip applies when you’re moving applications between
virtual desktops—if you have an application on the first desktop, just right-
click the brown window or the taskbar entry, select Move to Another Work-
space, and pick the relevant workspace number. The menu also has Move to
Workspace Left and Move to Workspace Right options. This makes moving
applications between your workspaces quite simple.

QUICK TIP Although Ubuntu has only two workspaces configured by default, you can have as many—
or few—as you like. To configure them, right-click on one of the workspaces in the bottom
right-hand corner of your screen, and select Preferences from the menu.

To the right of the workspaces is the trash. Files that are dragged onto this
icon are destined to be deleted. To fully delete these files, right-click the
trash and select Empty Trash.

TIP Usability and the Ubuntu Desktop
Throughout the development of the Ubuntu desktop, great care and attention have gone into
usability. As an example, the four corners of the screen are established as areas that are
simple to access—you don’t need to carefully mouse over the area and can instead just
throw your mouse to the corner. This is why each corner has an important feature. It makes
accessing each feature that little bit easier.

Ubuntu is filled with tiny usability improvements such as this that help make it as intuitive
and powerful as possible.
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Shutting Down Your Computer and Logging Out
Now that you’re becoming acquainted with Ubuntu, you’ll want to keep
using it as long as possible, but there will always come a time when you have
no choice but to leave your computer and go do something else. As you
have already seen, Ubuntu is extremely flexible, and this area is no excep-
tion. Click System > Log Out or the icon in the top right of the screen to see
the various options (shown in Figure 3-5) for ending your current comput-
ing session.

There are a number of options available upon logout, however, the choices
presented to you will depend on your installation (e.g., Suspend may not
be available).

� Log Out: This option lets you log out of the current session and go
back to the main login screen. 

� Lock Screen: This option locks the screen. This is useful when you
need to use the bathroom or grab some lunch. It will lock the
computer and ask for your password to reenable the desktop.

� Switch User: When you click this option, your user account remains
logged in, but another user account can be used. When the second
account logs out, Ubuntu reverts to the original one. 

� Suspend: If your computer supports Suspend, click this icon to
suspend the power. The next time your computer is turned on, the
desktop will be resumed.
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� Hibernate: When you click this option, the current state of the system
is saved to the hard disk and can be switched off. This is like the
Suspend option but slower.

� Restart: Click this to restart the computer.

� Shut Down: Click this to shut down your computer.

Using Your Applications
Now that you have gotten used to the desktop, let’s explore some of the
many applications included on your new system. By default, Ubuntu
comes with a wide range of popular and established applications to listen
to music, watch videos, create documents, browse the Web, manage your
appointments, read your e-mail, create images, and much more. These
applications have been vetted by the developers to ensure they are the best-
of-breed Linux applications available.

Although Ubuntu includes a range of different software applications, it is
likely you will want to install extra applications and explore other available
software. Fortunately, the Ubuntu system is built on a powerful founda-
tion that makes software installation as simple as pointing and clicking.
Click Applications > Add/Remove, and a dialog box appears that you can
use to install new applications. Just browse through the different cate-
gories and check the applications to install. Click the Apply button, and
the application is downloaded and installed for you.

This tool provides a simple way to access a limited core set of popular appli-
cations, but there are actually more than 20,000 packages available to your
Ubuntu system. Software installation is discussed in detail in Chapter 4.

TIP Another Way to Run Applications
Although you will most typically start your applications by selecting them from the Applica-
tions menu, you can also press Alt-F2 to bring up a box where you can type in the name of
an application and run it.

Browsing the Web with Firefox
Firefox is the default Ubuntu Web browser and provides you with a
simple, safe, and powerful browsing experience. Firefox has become one of
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the most successful open source projects in the world and continues to
garner huge popularity. With hundreds of millions of downloads and rap-
idly increasing browser share, Firefox has been an unparalleled success.

Fire up Firefox by clicking its icon (the first one next to the System menu)
on the panel or by selecting Applications > Internet > Firefox Web
Browser. Before long, you’ll be presented with the main Firefox window
(Figure 3-6).

The Firefox window looks similar to most Web browsers and includes the
staple back, forward, reload, and stop buttons, an address bar, and some
menus. These familiar-looking elements help you become acquainted
with Firefox, and if you have used Internet Explorer, Opera, Netscape, or
Safari before, you are sure to pick it up in no time.

Navigating your way around the Internet is no different in Firefox than in
any other browser—just type the Web address into the address bar and
press Enter. Firefox also has a few nice features that make it easy to access
your favorite sites. As an example, if you want to visit the Ubuntu Web site,
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you can just enter www.ubuntu.com (leaving off all that http:// nonsense).
Alternatively, you can just type in “Ubuntu,” and Firefox will do the equiv-
alent of going off to Google, entering “Ubuntu” as the search term, and
taking you to the first result for the search. This feature is incredibly handy
for popular sites that are likely to be at the top of the search results page.

TIP The search box next to the address bar can be used to do searches. By default, these
searches are on Google. To do a Google search, just type in your search term and press
Enter. You can also click the down arrow next to the “G” and select from a variety of other
sites to search, including the Ubuntu software archive Web site and Wikipedia 

This search box can be used to search just about anything. To add more search engines,
click the small icon and then select Manage Search Engines.

Tabbed Browsing If you are anything like any of the authors behind this
book, you look at a number of different Web sites each time you use the
Internet. It is not uncommon to have your Webmail open as well as
Wikipedia, some discussion forums like the Ubuntu Forums, news sites,
blogs, and more. Before long, your desktop is littered with browser win-
dows, and your taskbar is full to the brim.

Firefox has a nimble solution to this problem in the form of tabbed brows-
ing. If you are looking at your friend’s Web site about raccoons and decide
you want to check out your favorite sports player’s Web site, just click
File > New Tab or press Ctrl-T and—ta-da!—a new tab is unveiled in your
browser window. You can now load another page inside this tab.

The tabbed browsing fun doesn’t stop, though—oh no! When you are read-
ing the Web and you see a link you are interested in viewing, right-click the
link and select Open Link in New Tab. The page will load in the new tab,
and you can continue reading the article and view the link afterward.

Bookmarking Your Favorite Sites To bookmark the page you are viewing,
click Bookmarks > Bookmark This Page. In the dialog box that pops up,
use the combo box to select the folder to store the bookmark in. You also
have the option to add “tags” to your bookmark, which are like keywords
that can be used to sort and search for your bookmarks in the future.
When you have finished naming and tagging your bookmark, click Done
to save the bookmark.
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Save Time with Live Bookmarks Firefox also includes a special feature
called live bookmarks that automatically grabs content from a Web site with-
out your needing to visit it. As an example, go to http://fridge.ubuntu.com
(a popular Ubuntu news site), and you will see a small orange icon—which
indicates that this site has feed available—on the right side of the address bar.
Click this orange square, and you will be taken to a new page that previews
the feed and gives you the option of what you would like to use to subscribe
to it. Use the default option (Live Bookmarks), and click Subscribe Now. A
dialog box will pop up. Use the default values provided and click OK. A new
toolbar button is added, and when you click on it, a list of the items from the
Web site are displayed. Each time you start Firefox, it will quietly go away and
update this list so that you don’t need to visit the site yourself.

TIP If You Liked the Fridge
You may also like Planet Ubuntu at http://planet.ubuntu.com. This site collects the personal
blogs of a number of different Ubuntu developers. Planet Ubuntu gives a unique insight into
what the developers are working on.

Bolt It On, Make It Cool Although Firefox is already a powerful and flex-
ible Web browser, it can be extended even further using special plug-in
extensions. These extensions cover not only typical browsing needs but
also other more specialized extras that extend the browser itself.

To install normal Web plug-ins, just visit a site that requires the plug-in. A
yellow bar will appear at the top of the page, indicating that you are miss-
ing a plug-in necessary to fully take advantage of the page you are visiting.
Click the Install Missing Plug-ins button to grab the required plug-in. For
example, Ubuntu does not come with the Macromedia Flash plug-in
because it does not live up to Ubuntu software freedom requirements. As a
result, you will have to choose to install either Macromedia Flash or the
free software version Gnash separately if you want to use Flash.

To extend the browser itself with additional features, go to https://addons.
mozilla.org and browse for an extension that you are interested in. When
you find something you would like to install, click the Install link. A dialog
box will pop up asking you to confirm the installation. Click Install Now.
Your new extension will now download and install automatically. Typi-
cally, this requires a restart of Firefox, and then your extension is available.
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TIP Be Careful Where You Download
It is recommended that you download extensions only from http://addons.mozilla.org. If you
do need to install an extension from another site, make sure it is a site you trust. Otherwise,
the extension may contain unsafe software, viruses, or spyware.

Creating Documents with OpenOffice.org
Included with Ubuntu is a full office suite called OpenOffice.org. This
comprehensive collection contains applications for creating word process-
ing documents, spreadsheets, presentations, databases, drawings, and math-
ematical equations. The suite provides an extensive range of functionality,
including reading and writing Microsoft Office file formats, and can also
export documents as Web pages, PDF files, and even animations.

Let’s give OpenOffice.org a whirl by creating a letter with it. Start Open -
Office.org Writer by selecting it from the Applications > Office menu. When
it has loaded, you will be presented with the interface shown in Figure 3-7.
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If you have used a word processing program before, many of the common
interface elements, such as the buttons for setting font type and size, bold,
italic, underline, and alignment, look and behave the same. The OpenOf-
fice.org developers have designed the suite to be easy to migrate to if you
have used a program like Microsoft Office before. After a few hours play-
ing with OpenOffice.org, you are sure to know how to do what you need.

Start your letter by first choosing a nice font. In the font combo box, you
should see Times selected as the default. Click the box and instead choose
the lovely Bitstream Vera Sans font. Change the font size by clicking the
combo box to the right of the font box and selecting 10 as the size. With
the cursor on the left side of the page, add your home address to the letter.

Now press Enter to leave a blank line under the address, and click the Align
Right toolbar button (the icon looks like some lines aligned to the right). If
you are unsure of what a button does, hover your mouse over it to pop up
a tool tip. Now add to your letter the address of the recipient.

Press Enter again to leave a blank line, and type the main body of the letter.
Feel free to use the bold, italic, and underline buttons to add emphasis to
your words. You can also use other toolbar buttons to add items such as
bullet points and numbered lists and to change the color of the font. If you
want to add features such as graphics, tables, special characters, and frames,
click the Insert menu and select the relevant item. You can customize each
item added to the page by right-clicking the item and using the options
shown in the context menu.

When your letter is complete, you can save it by selecting File > Save,
by clicking the floppy disk toolbar icon, or by pressing Ctrl-S. The
default file format used by OpenOffice.org is the OpenDocument For-
mat. This file format is an official open standard and is used across the
world. The file format is slightly different for different types of applica-
tions (.odt for word processor files, .ods for spreadsheets, and so on),
but each format provides an open standard free from vendor lock-in.
You can also save in a variety of other formats, including the default for-
mats for Microsoft Office.
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TIP Vendor Lock-In?
In the proprietary software world, it is common for each application to have its own closed
file format that only the vendor knows how to implement. When a person uses the software
to create documents, the closed format means that only that specific tool can read and write
the format. As long as you want to access your documents, you need that tool. This is
known as vendor lock-in.

To combat this problem, the OpenOffice.org suite (and the vast majority of other open
source applications) uses an open file format that is publicly documented. In fact, the format
is a published standard under ISO/IEC 26300:3006. This means that other applications can
implement the OpenDocument file format, and you can be safe in the knowledge that your
documents will always be available and you are not locked in to any specific tool.

Another useful feature wedged into OpenOffice.org is the capability to
save your documents in the Adobe PDF format. PDF files have been
increasingly used in the last few years and are useful for sending people
documents that they should not change (such as invoices). PDF files pro-
vide a high-quality copy of the document and are well supported across all
operating systems. This makes PDFs ideal for creating catalogs, leaflets,
and flyers. To save a document as a PDF file, click the PDF button on the
main toolbar (next to the printer icon). Click the button, enter a filename,
and you are done. Simple.

Managing Your E-Mail and Calendars with Evolution
Evolution has been modeled around the all-in-one personal information
management tool. Within Evolution you can read your e-mail, manage
your schedule, store contact details, organize to-do lists, and more in a
single place. This makes Evolution useful for both businesspeople and reg-
ular users who want easy access to this information.

Setting Up Your E-Mail Account To use Evolution to read your e-mail, you
need to find out the following settings for connecting to your e-mail server
(you can get these details from your ISP or system administrator):

� Your type of e-mail server (such as POP or IMAP)

� Your mail server name (such as mail.chin.com)

� Your mail account’s username and password

� Authentication type (typically by password)
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� Your outgoing mail server type (typically SMTP)

� Your outgoing mail server name

TIP Evolution and Webmail
You can’t use Evolution to read Webmail such as Yahoo! Mail, or Hotmail unless you con-
figure your Webmail to output as POP and use SMTP to send e-mail. Consult your Web-
mail provider for more details on if and how you can access the mail with a local client like
Evolution.

Load Evolution by clicking the envelope and clock shortcut icon from the
panel (hover your mouse over the shortcuts to see what they are) or by
clicking Applications > Internet > Evolution Mail. When the application
loads, you are taken through a wizard to set up your e-mail server (as
shown in Figure 3-8).
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Click Forward to continue the setup, and after choosing to not restore
from a backup, you will be asked for your identity. Fill in your e-mail
address in the E-Mail Address box, and add the optional information if
you want to. The additional details are not essential for using Evolution.
Click Forward to continue.

You are next asked to choose what kind of e-mail server you have from the
drop-down box. When you make your selection, some additional settings
are displayed. Fill in the server name and the username. You may need to
adjust the Security and Authentication Type settings, but for most
accounts the default settings should be fine. Click Forward to continue.

The next page configures some options for receiving your e-mail. None of
these options are essential, although you may want to check the first box to
automatically check for new mail. Click Forward to continue. The next
screen configures the settings for sending e-mail. In the combo box select
the Server Type (typically SMTP) and add the server name to the Server
box. Click Forward to continue.

In the next screen enter a name to describe the account. The default entry
(your e-mail address) is fine, but you may want to add something more
meaningful such as “Work E-Mail” or “Home E-Mail.” When you have
added this, click Forward to continue. Finally, select your location from the
map. If you click on your area of the world, the map will zoom in. Once you
have done this, click Apply to complete the process and close the wizard.

With the wizard completed, the main Evolution interface will appear, as
shown in Figure 3-9.

On the left sidebar you can see a number of buttons to access the mail,
contacts, calendars, memos, and tasks components in Evolution. When
you click each button, the interface adjusts to show you the relevant infor-
mation about that component.

Working with Your E-Mail Inside the e-mail component you can see the
e-mail folders in the left panel and the list of messages in the top pane.
When you click on a message, it is displayed in the bottom pane, where
you can read it. With your new account set up, you will first want to go and
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grab the e-mail from your mail server. Click Send/Receive, and the mail is
retrieved from your server and any unsent mail is sent.

TIP Problems?
If you cannot connect to your mail server, there may be an error in your account configura-
tion. To edit your account settings again, click Edit > Preferences, select the account from
the list, and click Edit.

With your messages loaded, new e-mails are shown in bold in the top pane.
Move through the different e-mails using the up and down arrow keys, and
each message will be displayed. You can reply to a message by clicking the
Reply or Reply To All toolbar buttons. New e-mails can be created by click-
ing the New toolbar button. By default, new e-mails and replies are sent
automatically when you click the Send button in the compose window.
This way you don’t need to click the Send/Receive button to deliver them.

Managing Your Calendar  Inside calendar mode, Evolution provides a con-
venient way to manage your schedule, add new events, and view your
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Figure 3-9 Those of you who have used Microsoft Outlook should find the interface very similar.



 calendar in different ways. When you click the Calendars button to switch to
this mode, you can see the timetable for today as well as the month view. The
month view shows a couple of months in which the bold dates have events.

You can add two types of events to your calendar.

� Meetings: These are events with a specific group of people.

� Appointments: These are general events. 

To add a new appointment, navigate to the date you require using the cal-
endar, then right-click a time slot in the day view, and select New Appoint-
ment. Alternatively, simply click the New toolbar item. In the box that
pops up, fill in the Summary, Location, Time (adjusting the date if neces-
sary), and Description boxes. You can also select which calendar the event
appears on if you have multiple calendars configured.

TIP Multiple Calendars
Evolution supports multiple calendars. This is useful if you want different calendars for dif-
ferent types of events such as personal and work-related activities. To create a new calendar,
right-click the calendar list in the left sidebar and select New Calendar.

To add a new meeting, again find the date, right-click the day view, and
select New Meeting. Inside the dialog box that pops up, you need to add
the participants who are attending the meeting. You can add participants
in two ways: Use the Add button if they are not in your address book, or
use the Attendees button if they are in your address book.

When you click Attendees, a new dialog pops up with a list of attendees
down the left. You can use the Add and Remove buttons to add contacts to
(or remove them from) the different categories of Chairpersons, Required
Participants, Optional Participants, and Resources. Now, you probably
don’t have any contacts in there as you are just starting to use Evolution, so
use the main Contacts button on the left side of the main Evolution win-
dow to add some.

You can view your calendar in lots of different ways by clicking the differ-
ent toolbar buttons such as Week, Month, and List. Play with them and see
which ones are most useful to you.
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QUICK TIP Remember, you can access your appointments without opening Evolution by clicking on the
clock in the panel.

Creating Graphics with GIMP
The GNU Image Manipulation Program, affectionately known as GIMP
to its friends, is a powerful graphics package. GIMP provides a compre-
hensive range of functionality for creating different types of graphics. It
includes tools for selections, drawing, paths, masks, filters, effects, and
more. It also includes a range of templates for different types of media
such as Web banners, different paper sizes, video frames, CD covers, floppy
disk labels, and even toilet paper. Yes, toilet paper. 

Unlike Adobe Photoshop, GIMP does not place all of its windows inside a
single large window; instead, GIMP has a number of separate child win-
dows. This can be a little confusing at first for new users—especially those
used to Photoshop. To get you started, let’s run through a simple session in
GIMP.

An Example Start GIMP by clicking Applications > Graphics > GNU
Image Manipulation Program.

When GIMP loads, you will see a collection of different windows, as
shown in Figure 3-10.

Close the Tip of the Day window, and you are left with two other windows.
The one on the left in the screenshot is the main tool palette. This window
provides you with a range of different tools that can be used to create your
images. The window on the right provides details of layers, brushes, and
other information. GIMP provides a huge range of different windows that
are used for different things, and these are just two of them.

To create a new image, click File > New. The window shown in Figure 3-11
will appear.

The easiest way to get started is to select one of the many templates. Click
the Template combo box and select 640 × 480. If you click the Advanced
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Figure 3-10 GIMP does not put everything in one window like Adobe Photoshop.

Figure 3-11 Lots of templates are available, including one for toilet paper!



Options expander, you can also select the type of color used in the image
with the Colorspace box and the background fill. The Fill combo box is
useful for either selecting a fill color or having a transparent background.

Click OK, and you will see your new image window (Figure 3-12).

To work on your image, use the tool palette to select which tool you want
to use on the new image window. Each time you click on a tool in the
palette, you see options for the tool appear at the bottom half of the palette
window.

When you click the A button in the palette, it selects the text tool. At the
bottom of the palette, you see the different options. Click the Font button
that looks like an upper and lower case A (like Aa) and select the Sans Bold
font. Now click the up arrow on the Size box, and select the size as 60.
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Figure 3-12 Use the right mouse button on the image to access lots of GIMP
options and features.



Move your mouse over to the empty image window, and you will see the
mouse pointer change to a text carat. Click in the image, and a box pops up
in which you can enter the text to add to the image. Type in “Ubuntu.”
With the text entry still open, click the up arrow on the Size box so the text
fills most of the window. As you can see, you can adjust the text while it is
in the image. When you are happy with the formatting, click Close on the
text entry box. Your image should look a little like Figure 3-13.

Now click the button in the palette with a cross with an arrow on each end.
You can use this to move the text around. Click the black text, and move
the mouse.

Let’s now add an effect filter. GIMP comes with a range of different filters
built in. You can access these by right-clicking the image and selecting the
Filters submenu. 

For our image, right-click the image and select Filters > Blur > Gaussian
Blur. In the Horizontal and Vertical boxes select 5 as the value. Click OK,
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and the blur is applied to your text. Anything in GIMP can be undone by
clicking Edit > Undo or typing Ctrl-Z. Your image should now look like
Figure 3-14.

Now we are going to create another layer and put some text over our
blurred text to create an interesting effect. In your image window, click
Dialogues > Layers. The Layers window now appears (Figure 3-15).

Layers are like clear plastic sheets that can be stacked on top of each other.
They allow you to create some imagery on one layer and then create
another layer on top with some other imagery. When combined, layers can
create complex-looking images that are easily editable because you can
edit layers individually. Currently, our blurred text is one layer. We can add
a new layer by clicking the paper icon in the Layers dialog box. Another
window appears to configure the layer. The defaults are fine (a transparent
layer the size of your image), so click OK.

Using Your Applications 83

Figure 3-14 Several filters and effects are bundled with GIMP in Ubuntu.



Now double-click the black color chip in the palette window and select a
light color. You can do this by moving the mouse in the color range and
then clicking OK when you find a color you like. Now click the text button
from the palette and again add the “Ubuntu” text. When the text is added,
it will be the same size as before. Now use the move tool and position it
over the blurred text. Now you have the word “Ubuntu” with a healthy
glow, as shown in Figure 3-16!

The final step is to crop the image to remove the unused space. Click Tools
> Transform Tools > Crop, and use the mouse to draw around the Ubuntu
word. You can click in the regions near the corners of the selection to
adjust the selection more precisely. Click inside the selection, and the
image will be cropped. To save your work, click File > Save, and enter a file-
name. You can use the Select File Type expander to select from one of the
many different file formats.

Communicating with Pidgin
With the Internet steamrolling its way across the world, the ubiquitous
global network has become a part of everyday life and something you can
reasonably assume people have access to. This has in turn spawned a range
of Web-based services and, interestingly, a variety of methods for commu-
nicating with each other.
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Included with Ubuntu is Pidgin (formerly known as Gaim), a cornucopia
of different methods for instantly messaging your friends from within a
single program. Instead of having to install a separate client application to
talk to your friends on MSN, AIM, ICQ, and Jabber, Pidgin can do it all in
one place. Pidgin is available by clicking Applications > Internet > Pidgin
Instant Messenger.

Setting Up Your Accounts When you start Pidgin for the first time, you
will be asked if you want to add an account, as none have been configured
yet. Click the Add button to add a new account, and the Add Account box
appears (Figure 3-17).

QUICK TIP To add or edit accounts at a later date, click Accounts > Add/Edit within Pidgin to access
your account list.
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Figure 3-16 Combining steps as we have done can result in interesting effects
such as this.



This window adjusts which text boxes are available depending on the proto-
col chosen. The different networks available are listed as options in the Pro-
tocol box. To create an account, you will need to have an existing account on
one of the networks. Pidgin allows you to have different accounts on differ-
ent networks running together—you just create a new account for each pro-
tocol—or even multiple accounts on the same network.

When you have selected a protocol, fill in the remaining boxes. The Screen
Name box needs to contain your registered username (or e-mail address
for MSN), and the Password box needs the respective password to be
added. You can also use the Local Alias box to add an interesting name that
is displayed when other people see you online. If you want to configure
any other options, click the Advanced tab.

Using Instant Messaging With your account(s) set up, Pidgin will auto-
matically sign you in. When you are logged in, your list of contacts (known
as buddies in Pidgin) is displayed (Figure 3-18). Additionally, a little icon
will appear in the notification areas that will show that Pidgin is running,
your status, and if you have received any messages.
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Figure 3-17 Pidgin supports many different types of accounts (MSN, AIM, Jabber,
ICQ, IRC, and so on).



You can use the Buddies menu option to add more buddies to the list with
the Add Buddy option. To speak with a buddy, double-click the name, and
a window will pop up. To change your status or sign out, click the status
box at the bottom of your Buddy List and select the appropriate option.

Using IRC Included in Pidgin is support for IRC channels, and it has a
very nice interface for IRC discussion. To use the IRC feature, first create
an account. Next, sign on, and then click Buddies > Add Chat and enter
the IRC channel name in the Channel box. Finally, double-click on the
channel name to go to it.

Cutting-Edge Voice Over IP with Ekiga
Included with Ubuntu is a simple-to-use yet powerful Internet phone
called Ekiga. Formally known as GNOME Meeting, Ekiga lets you make
voice and video calls with other people across the Internet. In addition to
the traditional Microsoft Netmeeting support, Ekiga now supports SIP, a
protocol commonly used to allow people with software phones such as
Ekiga to communicate with people using hardware Voice Over IP phones.
SIP is an industry standard that many hardware phones, software phones,
services, and providers support.
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Figure 3-18 Pidgin provides quick and easy access to your buddies—just click
them to talk!



If you choose to use SIP, calls from one phone to another across the Inter-
net are free. In addition, many providers allow you to make calls to normal
landline phones for very little cost. Ekiga offers you the possibility to call
anyone in the world directly from your computer with little fuss.

You can access Ekiga by clicking Applications > Internet > Ekiga Softphone.

Setting Up When you first start Ekiga, you are guided through a setup
wizard (Figure 3-19).

Click Forward to get started, and you see the next page (Figure 3-20).

In this box, enter your first and last name (such as Frankie Banger). Click
Forward to continue.

You can now configure an Ekiga.net account (Figure 3-21).

At Ekiga.net, a free SIP service is offered. If you don’t have an account
(which is likely if this is the first time you have used Ekiga), click the Get an
Ekiga.net SIP Account button. Firefox is then loaded, and you can use the
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Figure 3-19 Setting up Ekiga is simple with the setup wizard.



online form to sign up. If you don’t want an account, just select the check-
box in the wizard saying you don’t want to sign up. If you do sign up, add
your username and password, and then click Forward.

Now you can configure your connection type (Figure 3-22).
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Figure 3-20 Adding your name makes it easier for people to find you online.

Figure 3-21 Ekiga.net offers a free SIP service.



Select the type of connection you have, and then click Forward.

Traditionally, one of the problems in the past with Internet phones has been
that you need to modify your firewall (if you are running one) to get the
phone working. This typically involved configuring your Network Address
Translation (NAT) settings. Luckily, Ekiga can detect the type of NAT set-
tings that you need (Figure 3-23).

After a few seconds of detecting your type of NAT, Ekiga will propose an
option. Click Yes to continue, and then click Forward.

Next, configure your audio (Figure 3-24).

Select ALSA from the box, and click Forward to continue.

You can now select the audio input and output devices (Figure 3-25).

These settings are used to ensure that you can hear and record the audio. To
test your settings, click Test Settings. If all is fine, click Forward to continue.

Next select the type of video manager (Figure 3-26).
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Figure 3-22 Be honest here—selecting a faster speed won’t make it any quicker!
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Figure 3-23 Traditionally, setting up NAT with Internet phones was a pain—until now.

Figure 3-24 Ubuntu supports different types of audio frameworks, but the
Advanced Linux Sound Architecture (ALSA) is the most common.
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Figure 3-26 Ubuntu supports different types of video, but V4L is the most common.

Figure 3-25 Make sure you get these settings right, or you won’t hear anything.



The video manager ensures that video is displayed correctly on your
screen. Select V4L from the list, and click Forward to continue.

The final setting to configure is your Web camera (Figure 3-27).

Ensure that your camera is plugged in, and select a device from the combo
box. If you can’t see any options, you will need to configure your camera
driver first. When you have selected a device, click Test Settings to verify
that it works.

Finally, a summary of your options is displayed (Figure 3-28).

Ekiga is now configured. Click apply!

Making a Call With the configuration wizard complete, the main Ekiga
window is displayed (Figure 3-29).
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Figure 3-27 Remember to look your best online!



You are now ready to make a call. Simply enter the phone number or SIP
address of the person you want to call, and click the Connect button next
to the address bar. The call is then connected, and you can begin talking.

On the left side of the window are a number of icons that do different things.
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Figure 3-29 The Ekiga window is simple and sleek.

Figure 3-28 Now you are all set to make calls.



� Text Chat: When in a chat, click this icon to open the text chat
window. You can use this to send text messages to the user.

� View Mode: Click this icon to select which view mode Ekiga is in. You
typically need this when in a video chat with someone.

� Address Book: Click this icon to access the address book. Here you
can save your contacts, and you can also access the Ekiga.net online
white pages to see who else is online.

� View Webcam: This icon switches on the Webcam so that you can see
the person you are speaking to.

In addition to these icons, there are some tabs located below the numeric
keypad. Click these tabs to configure the audio and video settings for Ekiga.

Exploring the Ubuntu Landscape
Unlike many other operating systems, Ubuntu includes a comprehensive
suite of applications right inside the system. This range of tools has been
selected to allow you to install Ubuntu and get your work done, communi-
cate with other people, read and create documents, watch and/or listen to
media, and more. Unfortunately, due to space restrictions, this book can
only skim over the surface of available applications.

To help remedy this a bit, here is a quick summary of many of the applica-
tions included on the Applications menu in Ubuntu, including how to
find the applications and a brief description.

� Text Editor

Applications > Accessories > Text Editor

This simple, yet powerful, text editor is ideal for editing documents,
making quick notes, and programming. Included is a range of plug-
ins for spell checking, statistics, file listings, and more.

� Calculator

Applications > Accessories > Calculator

For those times when you need to figure out a percentage or calculate
whether you are getting a raw deal from your employer, the calculator
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is there. It provides a range of functionality for simple and scientific
calculations.

� Terminal

Applications > Accessories > Terminal

Underpinning the desktop is an incredibly powerful command-line
core. This application puts a window around a command-line
interface and allows you to configure transparency, fonts, behavior,
and more. Essential for the command-line junkies among you.

� Dictionary

Applications > Accessories > Dictionary

The dictionary provides a great way to find out how to spell a word or
discover its meaning. The dictionary uses the latest definitions from
an online dictionary. For those of you who spent hours as a child
looking up rude words in the dictionary, hours of fun are guaranteed.

� Gnometris

Applications > Games > Gnometris

If you have too much time on your hands, a surefire way to waste it is
to play this version of Tetris. If you decide that single-player Tetris is
not enough, go and download gtetrinet with the Add/Remove
programs.

� Nibbles

Applications > Games > Nibbles

The classic worm game comes to Ubuntu. Another surefire way to
while away an afternoon.

� Mahjongg

Applications > Games > Mahjongg

For those of you who actually understand the rules of Mahjongg, this
application provides a great implementation of the game.
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� FreeCell Solitaire

Applications > Games > FreeCell Solitaire

There is a body of thinking that suggests that FreeCell may be
responsible for untold hours of lost productivity. If you are impatient
about playing Patience, select FreeCell Solitaire.

� Movie Player

Applications > Sound & Video > Movie Player

Although listed as a movie player, this application actually plays a
range of different types of media, including both video and audio.

� Sound Recorder

Applications > Sound & Video > Sound Recorder

If you need to record something, such as your voice for a podcast or
audio message, you can use this simple tool.

� CD Ripper

Applications > Sound & Video > Audio CD Extractor

This application, called Sound Juicer, allows you to convert songs on a
CD into songs that live on your hard disk or portable music player.

� System Monitor

System > Administration > System Monitor

To get an idea of the current performance or load on your computer,
click on this tool. The System Monitor lets you know which
applications are running and how much memory/processing power
they are using, and it also allows you to kill or restart processes that
are hogging the resources.

� Sudoku

Applications > Games > Sudoku

The increasingly popular logic game arrives on Ubuntu.
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� Disk Usage Analyzer

Applications > Accessories > Disk Usage Analyzer

Bits and bytes never looked so good! In case you were wondering
exactly where all your disk space had gone, this will help solve the
mystery.

� F-Spot Photo Manager

Applications > Graphics > F-Spot Photo Manager

Manage your photos, download off your camera, and send them up
to Flickr and other online photo sites.

Other Applications to Try There are literally thousands of available pack-
ages that can be installed on your Ubuntu computer. These packages span
a range of different areas, and this section covers some of the popular
ones. Coverage of software installation appears in Chapter 4. Try the fol-
lowing useful applications.

� Blender

Package to install: blender

Blender (Figure 3-30) is an incredibly powerful 3D modeling,
animation, rendering, and production studio. Blender amasses an
impressive range of functionality for creating photorealistic scenes,
animations, and real-time virtual walkthroughs. Blender is also fully
scriptable in Python.

� Inkscape

Package to install: inkscape

Inkscape (Figure 3-31) is a drawing package for creating Scalable
Vector Graphics (SVG). Ever since the SVG format was introduced, it
has taken the design world by storm. SVG allows the creation of
graphics that can scale to any size. Inkscape is a hugely flexible tool
for creating such graphics, and a huge range of icons and artwork in
open source projects are made in Inkscape.
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Figure 3-30 Blender

Figure 3-31 Inkscape



� Beagle

Package to install: beagle

Beagle (Figure 3-32) is a search system that indexes virtually
everything. After you install Beagle, you can search for “campfire,”
and it will return documents, images, Web pages, blog entries, instant
messaging conversations, and more that contain that term. Beagle is
still very much in development but is an incredibly useful tool.

� Bluefish

Package to install: bluefish

For those of you who want to create Web pages but prefer to write
code, Bluefish (Figure 3-33) is an excellent Web editor. Bluefish is a
lightweight but feature-rich editor with support for a range of
languages as well as HTML and CSS.
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The Ubuntu File Chooser and Bookmarks
One area in which the GNOME developers have worked hard is in creating
an intuitive and useful file chooser that is accessed in applications with File >
Open. You may be wondering why they have spent so much time on such a
small and seemingly insignificant part of the desktop. In reality, however,
finding files is one of the most frustrating aspects of using computers and
often involves digging through folder after folder to find what you need.
Luckily, the GNOME file chooser (Figure 3-34) helps cut down much of
this file hunting significantly.

The listing of files on the right-hand side is used to find the file you need,
and you can click on folders in this listing to traverse deeper into your sub-
folders. Note how each folder is displayed above the listing in a series of
buttons. You can click these buttons to easily jump back to parent folders
when needed.
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Figure 3-33 Bluefish



Aside from enabling you to manually pick files, the chooser also supports
bookmarks. On the left side of the chooser is a list of devices and bookmarks
labeled Places. These include your home directory (shown as your user-
name), Desktop (the files on your desktop), and File System (the entire hard
drive), as well as devices such as CD drives, floppy drives, and USB sticks.

To create your own bookmark, use the listing on the right to find the
folder that you want to bookmark, single-click it, and then click Add
below the Places box. The folder now appears in your bookmarks. Now
whenever you need to access that folder, just click the bookmark! In addi-
tion to putting the bookmark in the file chooser, it is also available in other
parts of the desktop, such as the Places menu and in the file manager.

Ubuntu in Your Language
When you installed Ubuntu, you were asked which language the system
should use. Although this sets the initial language for the system, you may
want to change the language at a later date. To do this, click System >
Administration > Language Support.
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Figure 3-34 The file chooser has a number of subtle features such as bookmarks.



Ubuntu supports a huge range of different languages, and many applica-
tions include a Translate This Application menu option in the Help menu
so that all Ubuntu users can contribute translations in their language(s). If
you would like to help with this effort, it is a fantastic contribution to the
Ubuntu project.

When the language selector first loads, it may ask you to update your lan-
guage packs. Just click Yes to continue. Inside the dialog box a number of
languages are listed, each of which has a Support checkbox listed next to it.
For each language that you want available on the system, check the rele-
vant boxes.

When you have selected the boxes, click the Apply button, and the appro-
priate language packs are downloaded and installed. Now use the Default
Language combo box to choose the new language. You need to log out and
log back in for the changes to take effect.

TIP Choosing a New Language
When you see the login screen, you can use the Language button to choose a language for
that specific login session. When you select the language, you are asked if you want to make
it the default language or use it just for that specific session.

Customizing Ubuntu’s Look and Feel
Whenever we put someone in front of Ubuntu for the first time, there
seems to be a uniform natural desire to tweak the look and feel of the desk-
top. It can be fun tweaking our desktops so they look just right, and
Ubuntu has great support for all kinds of adjustments. Do you want dif-
ferent-looking applications with a lime green background and crazy fonts?
No problem; just don’t show it to anyone else. . . .

Changing the Background
To change the background of your desktop, right-click it and select Change
Desktop Background. Inside the dialog box that appears, choose your wall-
paper by clicking on an image, and the desktop background will automati-
cally change. Ubuntu comes with a limited range of preinstalled wallpapers,
so it is likely that you will want to add your own wallpaper. To do this, save
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your wallpaper somewhere on your computer, and then use the Add Wallpa-
per button to select it. The new wallpaper can be selected from the list.

If you are not really a wallpaper kind of person and would prefer just a
color for the background, you can use the Desktop Colors controls at the
bottom of the dialog box. The combo box provides three different types of
background: Solid Color, Horizontal Gradient, and Vertical Gradient. Next
to the combo box, click on the color chip to select the relevant color(s).

Changing the Theme
When you are using your applications, the visual appearance of the but-
tons, scroll bars, widgets, and other bits and pieces are controlled by the
theme. The built-in theming system can make your applications look
radically different, and Ubuntu ships with a number of themes that you
can try.

Choosing a New Theme  To choose a new theme, click System > Prefer-
ences > Appearance and then click on the Theme tab. Inside the tab that
pops up are a number of themes that you can choose. Just click on a
theme, and the desktop will be adjusted automatically. You can further
customize your theme by clicking the Customize button. A new dialog box
appears that has tabs for the different parts of the theme you can config-
ure. Click each tab, and select an entry from the list to create your own
perfect theme.

Installing New Themes  To install a new theme, first head over to
http://art.gnome.org and find a theme that you like. You need to look for
Application Themes when browsing the site. When you find a theme that
you like, download it to your computer. Now Click System > Preferences >
Appearance, and click the Install button in the Theme tab. Using the file
chooser, find the theme that you just downloaded, and it will install auto-
matically. Now select your new theme from the list.

Configuring a Screensaver
To choose a different screensaver, click System > Preferences > Screen-
saver. The screensaver configuration tool then loads (Figure 3-35).
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On the left side of the window is a list of available screensavers. Click on a
screensaver and you will see a preview appear in the space to the right of
the list. You can then use the slider to select how long the computer needs
to be idle before the screensaver kicks in.

The Lock Screen When Screensaver Is Active checkbox can be selected to
lock the screen when the screensaver starts and, as such, requires a user to
enter the password to reactivate the desktop. This is useful if you work in
an office and want to ensure that no one tampers with your computer
when you are away.

Managing Your Files
Files are the tofu and potatoes of any computer, and they need to be man-
aged, copied, moved, renamed, grouped, and loaded. Included with Ubuntu
is a powerful yet simple file manager called Nautilus that integrates tightly
into your desktop. You’ll use it all the time even if you don’t often see the
name.
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Figure 3-35 A number of screensavers are bundled with Ubuntu.



Nautilus makes extensive use of drag and drop. Unlike the kind of file
manager used in Windows with its tree view and listing of files, Nautilus
displays files in a series of windows in which you can drag files around eas-
ily. For those who just can’t say goodbye to the tree view, Nautilus also sup-
ports that. Aside from providing a simpler user interface, Nautilus also
includes a number of useful features such as video and image previews,
emblems, bookmarks, permissions management, and more.

How Linux Stores and Organizes Files
Before we use Nautilus, it is worthwhile to have a crash course in how files
and folders are organized on a Linux system. If you have not used Linux
before, this is likely to be new to you because the layout is quite different
from Windows and Mac OS X.

TIP Folders and Directories
When reading about file management, don’t get confused by the terms folders and directo-
ries—both words describe the same thing.

In the Windows world, each disk drive is labeled with an identifying letter
such as C: for your hard disk and A: for the floppy drive. In the Linux
world, however, everything is part of the same filesystem organization. As
such, if you have two or three hard disks, a CD drive, and a USB stick all
plugged in, they will all be part of the same folder structure.

The diagram shown in Figure 3-36 should give you an idea of how every-
thing hangs together.
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Right at the top of the tree is the root folder, referred to as /. Inside this
folder are a number of special system folders, each with a specific use. As
an example, the /home folder contains a number of home directories for
each user on the system. As such, the mako user account has the home
folder set to /home/mako.

Which Folder Does What? The folder structure in a modern Linux distri-
bution such as Ubuntu was largely inspired by the original UNIX founda-
tions that were created by men with large beards. Although you don’t really
need to know what these folders do, since Ubuntu looks after the house-
keeping for you, some of you may be interested in the more important fold-
ers. For your pleasure, we present the Linux folder hit list in Table 3-1.
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Table 3-1 Linux Folders

Folder Use

/boot This folder contains important files to boot the computer, including the
bootloader configuration and the kernel.

/dev Each device on your system (such as sound cards, Webcams, etc.) has an
entry in this folder. Each application accesses the device by using the
relevant items inside /dev.

/etc Systemwide configuration files for the software installed on your system
are stored here.

/home Each user account on the system has a home directory that is stored here.

/lib Important system software libraries are stored here. You should never need
to delve into this world of the unknown.

/media Media devices such as CD drives and USB sticks are referenced here when
they are plugged in. More on this later.

/mnt Other devices can be mounted, too. Again, more on this later.

/opt Optional software can be installed here. This folder is usually used when
you want to build your own software. If you don’t build your own
software, you ignore this folder.

/proc/sys Information about the current running status of the system is stored here.

/root This is the home directory for the main superuser.

/sbin Software that should be run only by the superuser is stored here.

/usr General software is installed here.

/var This folder contains log files about the software on your computer.



Configuration Files In Table 3-1, /etc is described as storing systemwide
configuration files for your computer. Aside from these files that affect
everyone, there are also configuration files for each specific user. Earlier,
when you customized Ubuntu’s look and feel, the settings were applied
only to your current user account. So where are those settings stored?

Inside your home directory are a number of folders that begin with a dot
(.), such as .gnome2 and .openoffice2. These folders contain the configu-
ration settings for specific applications for that specific user. By default,
these dot folders are hidden in Nautilus because you rarely need to access
them. For future reference, you can view these hidden files and folders by
clicking View > Show Hidden Files.

You can start Nautilus from a number of different places, but the easiest
way to launch Nautilus is from the Places menu. Click on Places > Home
Folder to load your home folder. When the folder loads, you should see
something similar to what Figure 3-37 shows.
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Figure 3-37 Accessing your home folder files is as simple as clicking Places >
Home Folder.



The Nautilus window is split into two parts. The sidebar shows categories
of information such as bookmarks, folders, emblems (more on these
later), and more. In the main part of the window, you can see the subfold-
ers and files in the current folder. By default, Nautilus displays your book-
marks in the left sidebar and displays the contents of your home folder.

So, let’s play with Nautilus and see what you can do with it. The first
important skills to learn involve general file management. Many of the
tasks you need to do can be achieved by right-clicking your file/folder and
selecting the relevant option. There are also a number of options in the
Edit menu.

First, create a folder right-clicking the main part of the window and select-
ing Create Folder. A folder is added, and you can type in the name of it. If
you change your mind about the name, rename it by right-clicking and
selecting Rename. If you double-click on a folder, you can access it and
perform the same operations within that folder.

QUICK TIP Just as folders and directories are the same thing, so are folders and subfolders . . . well,
almost. When we refer to subfolders, we are referring to folders contained within another
folder. For example, /home is a folder, while we can refer to /home/mako as a subfolder of
/home.

Nautilus is also flexible in how your files are displayed. You can view the
files and folders as either the default collection of icons or as a list. To
switch to the list view, select View > View As List. You can also configure
the organization of how your files and folders are displayed by right-
 clicking the main part of the window and selecting one of the options in
the Arrange Items menu. Play with each of these options to see which ones
work best for you.

QUICK TIP Just like in the file dialog, Nautilus displays each of the different parts of the path as different
buttons. As an example, /home/mako/work would have three buttons: home, mako, and work.

Selecting, Copying, and Moving Files and Folders
Copying and moving files and folders are simple tasks with Nautilus and
can be done in a number of different ways. To test this, create two folders
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called Work and Invoices in your home directory. Save some files inside
each folder. You can quickly create empty files by double-clicking the
folder to go into it, right-clicking, selecting Create Document > Empty
File, and renaming the file to something useful. With a couple of folders
now complete with files in them, let’s move them around.

One method is to use two windows. Right-click the Work folder, and select
Open in New Window. You now have two windows open, one with the con-
tents of Work and one with the contents of your home directory. Now copy
the Invoices folder to the Work folder by clicking it and dragging it over to
the second window (which shows the contents of Work). By default, drag-
ging from one window to another copies the item.

Another option is to select what you want to copy and paste it. Selecting
items can again be done in a number of ways. One method is to click each
file/folder while holding down the Shift or Ctrl keys to make multiple selec-
tions. The difference between the two keys is that Shift allows you to select a
number of files and folders next to each other, and Ctrl selects independent
files and folders from anywhere in the folder-listing view. When you have
selected what should be copied, right-click and select Cut or Copy. Cut will
copy the original files but remove them, and Copy will just copy them while
leaving the original files intact. Now go to the destination folder, right-click
it, and select Paste. The files/folders are now added.

Using the Sidebar
The sidebar in Nautilus can be changed to a variety of views that should
cater to virtually all tastes. Each of these different sidebar views has a range
of functions. Table 3-2 explains each one.

Although you will probably stick with one in particular, it is not uncom-
mon to switch between options to achieve a particular task. For this rea-
son, the flexibility provided by the range of sidebar options is useful.

TIP Drag and Drop
If you want to put something in the Places view, drag and drop the item. The Ubuntu desktop
is filled with drag-and-drop shortcuts like this. If you think something could be dragged and
dropped, try it!
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Using Emblems
Emblems give you the ability to tag files and folders to indicate something.
These small graphical icons are used to say that the file/folder falls into a
particular category, visually signified by the emblem. As an example, you
may want to tag a file to indicate it is a draft.

When you select the Emblems sidebar, a range of different emblems
appears. To apply an emblem to a file/folder, just drag the emblem onto it.
You can drag multiple emblems onto the files to indicate multiple things.

Ubuntu and Multimedia
In recent years, multimedia has become an essential part of computing.
Watching DVDs and videos and listening to CDs and music have become
part and parcel of the modern desktop computer experience. These multi-
media capabilities have been further bolstered by the huge popularity of
legal music downloading. With a range of online stores for a variety of dif-
ferent types of music, it is not uncommon to listen to most of your music
without ever seeing a little shiny silver disk.

Installing Codecs
Multimedia files and disks come in a variety of different types, and each
type uses a special codec to compress the content to a smaller size while
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Table 3-2 The Different Nautilus Sidebar Options

Option Feature

Places (Default view) Includes the devices and bookmarks in the sidebar that
you typically see in the file chooser.

Information Displays some limited information about the current folder.

Tree Displays a tree view similar to Windows/Mac OS X. Those of you who
love the way Windows/Mac OS X works may want to use this.

History Displays a history of the folders you have clicked on.

Notes Allows you to write notes in the sidebar that are stored in the folder.
This is handy when you need to explain or make comments about the
current folder.

Emblems Lists the files and folders that have specific emblems attached. 



retaining a particular level of quality. To play this media, you need to
ensure that you have the relevant codecs installed. Ubuntu now makes this
easier by suggesting packages that provide a suitable codec when you open
a file that isn’t supported by the ones that are currently installed. Simply
double-click the file you want to open, and you should be provided with a
list of packages that you can install to enable support for the file you have
tried to open. Select the packages that seem appropriate, and click Install.

QUICK TIP If you double-click a file but no packages are suggested, you may need to change the pack-
age filter in the top right-hand corner to All Available Applications.

Codecs still remain a problem for open source software because of the
legal restrictions placed upon them. Certain codecs (including MP3, Win-
dows Media Format, QuickTime, and RealMedia) are proprietary and as
such have restrictions placed on their use, distribution, and licensing.

Although developers in the open source community have gone away and
created free implementations of some of these codecs, the licensing that
surrounds them conflicts with the legal and philosophical position that
Ubuntu has set. These codecs are not included not only because they are
legally dubious but also because they disagree with Ubuntu’s ethic of cre-
ating a distribution that is entirely comprised of free software in the freest
sense of the word.

QUICK TIP If you want to find out more about installing these codecs, see https://wiki.ubuntu.com/
RestrictedFormats.

To work toward resolving these problems, a number of developers are work-
ing on free codecs such as Ogg Vorbis and Ogg Theora that provide high-
quality results and open licensing. The Ogg Vorbis codec is used on audio
and can provide better results than MP3 at a smaller file size. The Ogg
 Theora codec is used for video and competes with the MPEG-4 codec.
Ubuntu includes the Ogg Vorbis and Ogg Theora codecs by default, and you
can encode and play back any media that uses those codecs out of the box.

Although the world would be a better place if all codecs were free, the real-
ity is different, and many Ubuntu users still want to play media com-
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pressed with proprietary codecs. Table 3-3 shows the most typical codecs
used to encode and play back media and lists their support in Ubuntu.

Listening to Audio Files
Ubuntu includes a powerful music player called Rhythmbox to organize
and play your music file collection. By default, Ubuntu will look for music
in the Music directory accessible in the Places menu.

Using Rhythmbox Load Rhythmbox (Figure 3-38) by clicking on Appli-
cations > Sound & Video > Rhythmbox Music Player. The Rhythmbox
window is split into a number of different panes, each displaying different
details about your music collection. The left pane (Source) lets you select
the source of the music, such as your media library, podcasts, and Internet
radio. Each of these options has a browser pane available to display the
source of the content. As an example, when you use the Library, one pane
displays the artists and one displays the albums. You can use this to navi-
gate your music.

Listening to Podcasts Podcasts are audio shows that you can subscribe
to, and they are increasingly becoming the new way to listen to audio and
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Table 3-3 Codec Support

Codec File Type Included Supported

MP3 .MP3 No Yes

Ogg .ogg Yes N/A

Windows Media Audio .wma No Yes*

Wave .wav Yes N/A

MPEG-1 .mpg No Yes

MPEG-2 .mpg No Yes

Raw DV .dv Yes N/A

Quicktime .mov No Yes*

Windows Media Video .wmv No Yes*

* These codecs involve the installation of nonfree software that may or may not be legal in
your country.



music. When you subscribe to a podcast, each new release is automatically
downloaded for you. This makes it extremely convenient to regularly lis-
ten to audio shows.

If you are new to podcasting, you should grab yourself a podcast feed of
something you like. A site such as www.podcast.net is a good place to start.
Go to the site in Firefox, and when you see a link that indicates a podcast
feed or RSS feed, right-click it and select Copy Link Location.

Rhythmbox has good support for Podcast feeds, and subscribing to a feed
is simple. In the sidebar, right-click the Podcasts entry and click New Pod-
cast Feed. Paste in the feed by right-clicking the box and selecting Paste.
The files are automatically downloaded, and you can listen to them by
double-clicking on them. Each time you start Rhythmbox, a check is made
to see if any new episodes exist, and if so, they are downloaded.
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Figure 3-38 Rhythmbox is a great place to look after your music collection.
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NOTE Rhythmbox and iPods
Rhythmbox can also read songs from your iPod—just plug it in and it will display in Rhythmbox.
Rhythmbox can read from the iPod but may not be able to write to all iPods..

Playing and Ripping CDs
When you pop a CD into your CD drive, Audio CD Extractor (Sound
Juicer) automatically loads to play your CD. If you are connected to the
Internet, the CD is looked up on the Internet, and the album details and
song titles are displayed.

Ripping Songs as Oggs Sound Juicer is not just a CD player but a ripper
too. Using a ripper you can convert the songs on the CD into files that you
can play on your computer. By default, Sound Juicer rips the files in the
Ogg format, which provides better sound quality than MP3 at a smaller
size. By default, the ripped files are stored in the format discussed earlier,
with each artist as a folder and albums as subfolders.

To rip the songs, just select the checkboxes of the songs you want ripped
(by default, all songs are selected), and then click Extract. Each song is
then stored in your Music folder, and the song titles are used as the names
of the files.

Ripping Songs as MP3s Although the default Ogg support is recom-
mended in most situations, you may prefer to rip MP3 files if you have a
digital audio player that does not support Ogg files. To do this, you need to
configure Sound Juicer to enable MP3 support.

You should first install the gstreamer0.10-plugins-ugly-multiverse pack-
age (see Chapter 4 for more details on installing packages). Next, in Sound
Juicer, click Edit > Preferences and choose the CD Quality, MP3 (MP3
audio) profile from the Output Format options.

Watching Videos
To watch videos in Ubuntu, you need to ensure that you have the correct
codecs installed. As discussed earlier, some of these codecs are available
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separately due to the legal implications of including them with the
Ubuntu system. Although the new process for suggesting and installing
codecs should cover most popular types of files, you should still refer to
the Ubuntu wiki at http://wiki.ubuntu.com for details of how to install
ones that are not recognized.

Using Totem To watch videos in Ubuntu, you use the Totem media player
(Figure 3-39). Load it by clicking Applications > Sound & Video > Movie
Player.

To watch a video on your hard disk, click Movie > Open, and select the file
from the disk.

TIP Another Way to Load Files into Totem
You can also load multimedia files into Totem by double-clicking them on your desktop or in
the file manager.

Totem also supports video streams. To watch a stream, click Movie > Open
Location, and enter the Internet address for the stream. The video feed is
then loaded and displayed.
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Figure 3-39 Totem is a simple and flexible media player.

http://wiki.ubuntu.com


Getting DVDs to Work Ubuntu comes with DVD support for unen-
crypted DVDs. With the DVD industry being what it is, the majority of
DVDs come encrypted, and if you want to watch them, you need to ensure
that a library that can decrypt these DVDs is installed. Unfortunately, this
library needs to be installed separately and is not included with Ubuntu.
Refer to the Ubuntu wiki restricted formats page at https://wiki.ubuntu.
com/RestrictedFormats for details.

With the library installed, insert a disk into your computer, and Ubuntu
will automatically start Totem to view the disk. Alternatively, fire up
Totem, and click Movie > Play Disk to play the DVD. Totem doesn’t sup-
port DVD menus but you can still use it to play a DVD.

If you are settling down to watch a movie, you may want to configure a few
other settings. First click View > Aspect Ratio to select the correct aspect
ratio for your screen, and then select View > Fullscreen to switch to full
screen mode. To exit full screen, just move your mouse, and some on-
screen controls will appear.

TIP Control Totem with a Remote Control
Totem supports the Linux Infrared Control (LIRC) library so you can use a remote control
while watching your media.

Summary
In this chapter you’ve learned how to start using the core features of your
new desktop. These concepts should allow you to perform most of the
day-to-day tasks when using your computer and provide a base from
which to explore the other applications installed on your system. This
solid grounding in the desktop paves the way for you to meander through
the rest of the book, learning about the more advanced uses of your new
system and exploring the enormous flexibility that Ubuntu provides.

Always remember that there is a wealth of help and documentation avail-
able online. If you ever find yourself stuck, take a look at the Ubuntu Web
site at www.ubuntu.com or the Ubuntu documentation at http://help.
ubuntu.com and make use of the forums, wiki, mailing lists, and IRC
channels.
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. (dot) prefix files, 108
* (asterisk), wildcard character, 392
$ (dollar sign), UNIX shell symbol, 165
&& (double ampersand), running multiple

commands, 225
# (hash character), comment indicator, 163
- (hyphen), dash in commands, 141
? (question mark), wildcard character, 392
| (vertical bar), pipe symbol, 140, 393
[ ] (brackets), wildcard characters, 392
[! ] (brackets, exclamation point), wildcard

characters, 392
; (semicolon), running multiple commands, 225
~ (tilde), home directory indicator, 141, 165
3D mapping, Kubuntu, 319
3D modeling, 98–99, 422

Abiword, 419
Access, 420
Access permissions. See Permissions.
Accessibility options, 20, 297
Accounting software, Ubuntu/Windows

equivalents, 421
addgroup command, 390
Adding

programs. See also Installing.
Adept package manager, 286
Edubuntu, 350–351
Kubuntu, 286
LTSP, 350–351
Ubuntu, 120–122

user accounts, 390
user groups, 390

Add/Remove Applications, 120–122
Address book, 95
adduser command, 173, 390
Adept package manager. See also Installing

Kubuntu.
adding/removing programs, 286
authentication, 289–290
components, 285
installer, 285
installing applications, 286
installing packages, 284–285, 291–293
main repository, 288
managing repositories, 288–291
multiverse repository, 288
package details, viewing, 292
previewing changes, 292–293
restricted repository, 288
search feature, 287, 291
starting, 286
third-party repositories, 289–290
universe repository, 288
update notification, 293–296
update-notifier, 285
Updater, 293–296
updates, default settings, 289–290
usage statistics, 290–291

Adept update-notifier, 285
Adept Updater, 293–296
Administration features, password, 63
Advanced Package Tool (APT), 123, 162–164
Advanced tab, System Settings window, 300
Advanced User Settings, System Settings

window, 300



Advocacy, 267
AIM, 421
Akregator, 315–316
Alternate install CD. See Installing Ubuntu from

alternate install CD.
AMD64 architecture, Ubuntu support, 34
Ampersands (&&), running multiple

commands, 225
Anagram creator, 329
Animation, 98–99
Announcements, 245
Answers, 28, 382–383
Appearance section, System Settings window, 297
Applets, 64. See also specific applets.
Application Launcher, 277–281
Applications. See also specific applications.

closing, 60
compiling, 192–193
graphical, remote access, 208–209
LTSP, adding/removing, 350–351
maximizing, 60
minimizing, 60
non-Synaptic, installing, 189
open, displaying, 65–66
required tools, verifying, 193
sound won’t play, 202
starting, 60–62, 68
switching between, 65–66
troubleshooting. See Troubleshooting,

applications.
vendor lockup, 74
window won’t close, 196
won’t close, 196
writing and tracking, 28

Applications menu. See also Desktop, Ubuntu.
Calculator, 95–96
CD ripper, 97
customizing, 61
description, 60
Dictionary, 96
Disk Usage Analyzer, 98
FreeCell Solitaire, 97

F-Spot Photo Manager, 98
games, 96–97
Gnometris, 96
Mahjongg, 96
Movie Player, 97
Nibbles, 96
Sound Recorder, 97
starting applications, 60
Sudoku, 97
System Monitor, 97
Terminal, 96
Text Editor, 95

Appointments, 78. See also Calendars.
APT (Advanced Package Tool), 123, 162–164
apt-cache utility, 165–168
apt-get utility, 165–168
aptitude utility, 170–171
Archive management, 379
Array failure, 156
Array management, 161
Artwork, user contributions, 268–269
Asterisk (*), wildcard character, 392
Astronomy programs, 331–332, 422
Audio. See also Music.

burning CDs, 309–310
configuring, LTSP, 353–354
customizing, Kubuntu, 297
distortion, 203
doesn’t play, 202
Ekiga, 90–92
iPods, 115
listening to, 113–115
MP3 format, 115
Ogg format, 115
playing CDs, 115
podcasts, 113
Rhythmbox, 113
ripping CDs, 97, 115
Sound Juicer, 115

Authentication, Kubuntu, 289–290
Automatic login, 194, 320
Autopackages, 192
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Background, desktop. See also Themes.
changing, 203–204
configuring, 103–104
finding, 204
installing, 204
Kubuntu, customizing, seek KDE desktop
online source for, 204
Ubuntu, 103–104

Backing up data
boot sector, 183–184
RAID, 155

Backports repository, 162
Bacon, Jono, 242
Baker, 133
Banshee, 420
Base, 420
Basinger, Mike, 264
Bazaar, 27, 384
Beagle, 100
Beep Media Player, 420
BIOS configuration problems, 38
Blanking screens, Edubuntu, 361
Blender, 98–99, 422
Blogs

for developers, 71
Planet Ubuntu, 258–259

Bluefish, 100–101
Blueprint, 28, 381–382
Bluetooth, 217
Bookmarking

files and folders, 102
live bookmarks, 71
Web sites, 70

Books. See Documentation; Help.
Boot failure, 183–184
/boot folder, 107
Boot logo appears corrupted, 184–185
Boot sector, backing up and restoring, 183–184.

See also MBR.
Bootloader, 183–184
Brackets, exclamation point ([! ]), wildcard

characters, 392

Brackets ([ ]), wildcard characters, 392
Bread, baking, 237–238
Browsing media files, 304
Buddies menu, Pidgin, 87
Bug #1, 24–25
Bugs

Bug #1, 24–25
debugging. See Technical support;

Troubleshooting.
fixes, goals of Ubuntu, 23
Malone, 24–25, 28
reports, filing, 234–237
tracking, 24–25, 28. See also Launchpad; Malone.
user involvement, 269

Bulletin boards. See The Fridge; IRC (Internet
Relay Chat); Mailing lists; Wikis.

Burger, Corey, 264
Burning CDs. See CDs, burning.
Buttons in window border, 60
Buying installation CDs, 36

Calc, 307–308, 419
Calculators, 95–96, 318
Calendars

accessing from the clock, 79
appointments, 78
on the desktop, 65
Evolution, 77–79
Kubuntu

Kontact, 312–316
KOrganizer, 314–315

meetings, 78
view formats, 78

Cameras. See Digital cameras.
Canonical Ltd.

Bazaar, 27
formation of, 11–12
geographical location, 26
Launchpad, 27–29
service and support, 26–27
structure of, 25–26
working with other companies, 26
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Cardbus adapter not recognized, 213–214
cat command, 390. See also zcat command.
cd command, 386
CD images. See .iso files.
CD ripper, 97
CD/DVD Burner, 132
CD/DVD burners, 132–133
CD/ROM won’t eject, 216
CDs. See also Audio.

alternate install. See Installing Ubuntu from
alternate install CD.

audio
burning, 132, 309–310
creating, 97
playing, 115
ripping, 97, 115

burning. See also CD/DVD burners.
accessing the burner, 132
audio and data, 132, 309–310
configuring, 132
from images, 132
installation image files, 36–38, 132
.iso files, 36–38, 132
K3b program, 309–310
Kubuntu, 309–310

copying. See CDs, burning.
desktop. See Installing Ubuntu from desktop

CD.
installation. See Installation CDs.

Celestia, 422
chmod command, 387
chown command, 388
Client management, Edubuntu

kernel version, updating, 357–359
LTSP setup, 343–344
NFS root, updating, 356–357

Clock
accessing the calendar, 79
Kubuntu, 297
LTSP, 341–342
Ubuntu, 65

Closing applications, 60

CoC (Code of Conduct), 20–22, 395–398
Code modifications, licensing, 407
Codecs, 111–113
Collaboration, code of conduct, 396–397
Commands

command-line interface. See Terminal
commands.

help for, 231
Commercial distributions, 376
Community Council, 242, 262–264
Community of users. See Ubuntu community.
Compiling applications, 192–193
Compression, multimedia, 111–113
Computer administration

Kubuntu. See Kubuntu, system administration.
troubleshooting. See Troubleshooting, system

administration.
Computer Administration section, System

Settings window, 297–299
Computer icon, 62
Computers, older or less powerful. See

Xubuntu.
Conferences, 256–258
Configuration files, 108
Configuring. See also Customizing.

BIOS, 38
desktop

background, 103–104
menu layout, 61–62
preferences, 63
screensavers, 104–105
themes, 104–105

Edubuntu server. See Edubuntu, server
management.

Ekiga, 88–93
keyboard layout

alternate install CD, 49
desktop CD, 41
Edubuntu, 340
Kubuntu, 297
Ubuntu, 41, 49

Kubuntu, 277–281
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printers, 133–138
user accounts, 45–46, 54

Conflicts of interest, 400
Connect to Server option, 63
Connection type, Ekiga, 89–90
Consideration for others, 396
Contacting Ubuntu developers and users. See

Ubuntu community, communication
venues.

Coordinated Universal Time (UTC), 
341–342

Copying
files

between computers, 225–226
cp command, 387
Kubuntu, 304
Ubuntu, 109–110, 387

folders, 109–110
photos from mobile phone, 217

Core philosophical ideals, 401. See also
Philosophical ideals.

cp command, 387
Crediting achievements, leadership code of

conduct, 399
cron, 223
crontab command, 223–225
crontab file, 223–225
Cropping images, 84
Cunningham, Ward, 250
Current directory, identifying, 385–386
Customizing. See also Configuring.

background, 103–104
Kubuntu. See Kubuntu, customizing.
menu layout, 61–62
Places menu, 61
preferences, 63
screensavers, 104–105
themes, 104–105
Ubuntu desktop

background, 103–104
menu layout, 61–62
preferences, 63

screensavers, 104–105
themes, 104–105

Dapper Drake 6.06 LTS, 3, 23, 140
Data replication with RAID, 153
Databases

IBM DB2 database, Ubuntu support, 26
of stars, 331–332
Ubuntu/Windows equivalents, 420

Date and time. See also Clock.
Kubuntu, 297
LTSP, 341–342

.deb file extension, 163
Debian package manager, 163–164
Debian project, 16–17
debmirror process, 189
Debs, 163
Default installation, licensing, 408
DEFAULT keyword, 347–349
Degraded mode, 156
Delegation, leadership code of conduct, 399
Deleted items, restoring, 190–191
Deleting. See also Removing.

files, 304, 387
user accounts, 173, 390
user groups, 390

delgroup command, 390
Dell laptops, Ubuntu support, 26
deluser command, 173, 390
Derived distributions. See also Distributions;

Ubuntu editions.
for the Andalusian government, 374–375
commercial distributions, 376
Freespire, 376
gNewSense, 375–376
Guadalinex, 374–375
Linspire, 376
for low-power computers, 376–377
Nexenta OS, 377
Open CD, 377
for restricted code, 375–376
for the Solaris kernel, 377

Index 427



Derived distributions, continued
Spanish language, 374–375
Ubuntulite, 376–377
for Windows, 377

Desktop
Edubuntu

blanking screens, 361
lockdown editor, 361–362
locking screens, 361
logging users out, 360
Pessulus lockdown editor, 361–362
plug-ins, 362
process management, 360
resolution, 342
sending messages, 361
starting programs, 361
Thin Client Manager, 359–360
user groups, 362

KDE (K Desktop Environment). See KDE
desktop.

Kubuntu. See KDE desktop.
Desktop, Ubuntu. See also Applications menu;

GNOME.
adding TrueType fonts, 187
applets, 64
applications

closing, 60
maximizing, 60
minimizing, 60
open, displaying, 65–66
starting, 60–62
switching between, 65–66

buttons in window border, 60
calendar, 65
clock, 65
customizing

background, 103–104
menu layout, 61–62
preferences, 63
screensavers, 104–105
themes, 104–105

desktop area, 60

Desktop folder, accessing, 62
device icons, 60
emptying the trash, 66
files on, location, 62
help and support, 63
hiding/showing, 65–66
Home folder, accessing, 62
hung, 194
icons, application. See Applications menu.
installing a new environment, 188
language selection, 59
main areas, 59–60
notification area, 65
panel, 59
Places menu, 62–63
preferences, 63
problem reporting, 63
shortcut icons, 64
speeding up, 226–227
system configuration, 63
System menu, 63
taskbar, 60, 65–66
themes and backgrounds, 203–204
trash, 66
usability, 66
wastebasket, 66
workspaces, 66

Desktop area, 60
Desktop Effects, disabling, 226
Desktop folder, 62
Desktop install CD. See Installing Ubuntu from

desktop CD.
Desktop machines vs. servers, 23. See also

Ubuntu Server.
Desktop publishing, 421. See also Word

processing.
Desktop section, System Settings window, 

297
/dev folder, 107
Developer blogs, 71
Developer sprints, 254–256
Developer summits, 254–256
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Development discussions. See Blogs; IRC
(Internet Relay Chat); Mailing lists;
Wikis.

Device file creation, disabling, 174
Device icons, 60
Devices. See also specific devices.

detecting, Kubuntu, 298–299
problems with. See Troubleshooting,

hardware.
Ubuntu compatibility, determining, 222

df command, 388
DHCP servers, Edubuntu, 345–346
Dia, 422
Diagram editing, 422
Dictionary, 96
Digital cameras, 133, 300
Digital Millennium Copyright Act (DMCA),

200–201
Digital photography

F-Spot Photo Manager, 98, 133
GIMP Image Editor, 133. See also GIMP

(GNU Image Manipulation Program).
Direct memory access mode (DMA), enabling,

201
Directories. See also Folders; Terminal

commands, files and folders.
changing, 386
creating, 387
current, identifying, 385–386
definition, 106
files in, listing, 387
working, printing, 385–386

Disk storage. See also CDs; USB storage devices.
across physical boundaries. See RAID

(redundant array of inexpensive
disks).

drives, searching for, 62
fixing, 229–230
floppy disks, 131, 133
formatting, 219–220
freeing, 195–196
fsck program, 229–230

hard disks. See also LVM (Logical Volume
Manager).

mounting/unmounting, 131
partitioning. See Partitioning disks.
usage analysis, 97

reads but won’t write, 218–219
recovering from power failure, 229–230
space, reducing, 230
space usage, displaying, 388
USB keyring devices, 131–132

Disk Usage Analyzer, 98, 195
Diskless clients, 334
DISPLAY option, 347–349
Display section, System Settings window, 298
Displays. See Monitors; Screens.
Dispute resolution, 263, 397
Distribution management, 379
Distribution upgrades

description, 168
do-release-upgrade tool, 168
interrupting, 169
packages, building from source, 169–170
run time, 169
update-manager-core tool, 168

Distributions. See also Derived distributions;
specific distributions.

definition, 12
description, 12–14
differences between, 35–36. See also specific

distributions.
diversity of, 14–16
educational purposes. See Edubuntu.
with KDE desktop. See Kubuntu.
managing, 28
for older computers. See Xubuntu.
repositories of, 14–16

Distro. See Distribution.
Distrowatch database, 14
DMA (direct memory access mode), enabling,

201
DMCA (Digital Millennium Copyright Act),

200–201
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Documentation
See also Help
See also Online resources
See also Ubuntu community, communication

venues
See also Ubuntu foundation documents
command-line interface, 391–392
licensing, 407–408
man pages

for commands, 231
finding, 391–392
Terminal, 143

Ubuntu foundation, Ubuntu foundation
documents

user involvement, 268
wikis, 250–253

Documents
creating, 72–74. See also Desktop publishing;

Word processing.
recently-used, searching for, 63

Dollar sign ($), UNIX shell symbol, 165
Dolphin file manager, 302–303
do-release-upgrade tool, 168
Dot (.) prefix files, 108
Downloading packages, 165–168
dpkg utility, 163–164
Draw program, 307–308
Drawing programs. See also Image editing.

3D modeling, 98–99
animation, 98–99
Draw, 307–308
Kubuntu, 307–308
production studio, 98–99
rendering, 98–99
SVG (Scalable Vector Graphics), 98–99
Tux Paint, 333–334
Ubuntu/Windows equivalents, 422

Drivers
licensing, 407–408
printer, 136
restricted, 186

Dual boot
creating, 233–234
definition, 41
Edubuntu, 347–349
LTSP (Linux Terminal Server Project), 347–349
operating systems supported, 234
partitioning for, 42–43, 43
QEMU project, 234
running a virtual computer, 233–234
troubleshooting, 233–234

DVDs
DMA (direct memory access mode),

enabling, 201
encryption, 117
not working, 216
playback is jittery, 201
support package for MythTV, 205
troubleshooting, 200–201
won’t eject, 216
won’t play, 201

East, Matthew, 264
Editions of Ubuntu. See Derived distributions;

Ubuntu editions; specific editions.
Edubuntu. See also LTSP (Linux Terminal

Server Project).
adding/removing programs, 350–351
blanking screens, 361
client management

kernel version, updating, 357–359
NFS root, updating, 356–357

description, 30–31, 371–372
desktop management

blanking screens, 361
lockdown editor, 361–362
locking screens, 361
logging users out, 360
Pessulus lockdown editor, 361–362
plug-ins, 362
process management, 360
resolution, 342
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sending messages, 361
starting programs, 361
Thin Client Manager, 359–360
user groups, 362

downloading, 326
Educational menu, 327–334
forums, 366
goals of, 325
help, 365–366
history of, 325–326
installing. See Installing Edubuntu.
IRC (Internet Relay Chat), 366
lockdown editor, 361–362
locking screens, 361
logging users out, 360
mailing list, 365–366
Pessulus lockdown editor, 361–362
plug-ins, 362
process management, 360
sending messages, 361
server management

adding/removing programs, 350–351
installing applications, 350–351
IP address, changing, 352
local devices over LTSP, 352–353
password display, 352
printing over LTSP, 354–355
sound over LTSP, 353–354
SSH keys, updating, 352
updating the server, 349
USB sticks under LTSP, 352–353
window manager alternatives, 355–356

sources for, 326
starting programs, 361
Thin Client Manager, 359–360
vs. Ubuntu, 35
user groups, 362
Web sites about, 365

Edubuntu, applications
anagram creator, 329
astronomy, 331–332

for children, 334
drawing package, 333–334
educational, 327–334
factoring numbers, 329
foreign language tutorials, 333
fraction exercises, 329
function graphing, 331
GCompris, 334
GCompris Administration, 327
geometrical constructions, 330
graphing, 331
hangman game, 329–330
Kalzium, 328
Kanagram, 329
KBruch, 329
KEduca, 329
KEduca-Editor, 329
KHangman, 329–330
Kig, 330
KmPlot, 331
KPercentage, 331
KStars, 331–332
KTouch, 332
KTurtle, 332–333
Kverbos, 333
KVocTrain, 333
Logo programming language, 332–333
math

factoring numbers, 329
fraction exercises, 329
function graphing, 331
geometrical constructions, 330
KBruch, 329
Kig, 330
KmPlot, 331
KPercentage, 331
percentage exercises, 331

percentage exercises, 331
periodic table exploration, 328
Spanish language tutorial, 333
spelling exercise, 329–330
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Edubuntu, applications, continued
standard, 327
stars database, 331–332
test creation and administration, 329
touch-typing tutorial, 332
Tux Paint, 333–334

Educational applications, 327–334
Educational menu, 327–334
Educational software, Ubuntu/Windows

equivalents, 422
Education-oriented Ubuntu. See Edubuntu.
Edutainment, Ubuntu/Windows equivalents,

422
Effect filters, 82–83
Ejecting CDs and DVDs, 216
Ekiga

address book, 95
audio configuration, 90–92
configuring, 88–93
connection type, configuring, 89–90
description, 87–88
firewall modifications, 90
making a call, 93–94
SIP protocol, 87–89
starting, 88
text chat, 95
video configuration, 90–93
view mode, 95
Voice Over IP communication, 8
webcam, 93, 95

Ekiga Softphone, 421
Electrical power

conservation, Kubuntu, 298
conserving, 67, 298
failure, disk recovery, 229–230
suspending, 67, 298

Elkner, Jeff, 325
E-mail

address, configuring, 199
doesn’t work in Evolution, 199–200
Hotmail, 75

Kubuntu, 312–316
sending/receiving, 77–78
setting up, 74–76
troubleshooting, 199–200
Ubuntu/Windows equivalents, 420
unable to connect to server, 77
Webmail, 75
Yahoo! Mail, 75

Emblems, files and folders, 111
Emptying the trash, 66
Encryption, DVD, 117
Epiphany, 420
/etc folder, 107
Etrich, Matthias, 272–273
Evolution, 75–79, 199–200, 420
Excel, 307–308, 419

Factoring numbers, 329
Fault tolerance

LVM (Logical Volume Manager), 160
RAID (redundant array of inexpensive disks),

153
Favorites list, Kubuntu, 280
Feature tracking, Launchpad, 381–382
File associations, Kubuntu, 300
File chooser, 101–102
File Manager

displaying hidden files and folders, 190–191
freeing disk space, 195–196
restoring deleted items, 190–191
scripting, 197–198
speeding up, 190
viewing freed disk space, 195–196

Files. See also Folders; Terminal commands, files
and folders.

. (dot) prefix, 108
access record, disabling, 175
bookmarking, 102
command-line interface to. See Terminal

commands, files and folders.
configuration, 108
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copying
between computers, 225–226
cp command, 387
Kubuntu, 304
Ubuntu, 109–110, 387

deleting, 387
emblems, 111
execution, disabling, 174
finding, 62–63, 101–102
hidden, 108, 190–191
Kubuntu. See Kubuntu, file management.
listing

by folder, 139–140, 387
with the ls command, 139–140
by package, 171

moving, 109–110, 387
owner, changing, 388
owner, finding, 171
package owner, finding, 171
package provider, finding, 171–172
permissions, changing, 387
provider, finding, 171–172
remote, accessing, 138–139
selecting, 110
storing and organizing, 105–109
tagging, 111
text, concatenating, 390
text, searching and editing, 389–390
transferring with SSH, 207–208

Filesystem
creating, 220
default, 44–45
determining, 219
hardware issues, 218–219
navigation, 385–386
security issues, 174–175
Ubuntu Server, 174–175

Filtering packages, Kubuntu, 291–292
Filters, graphic, 82–83
Finance programs, Ubuntu/Windows

equivalents, 421–422

Finding. See also Search tools.
desktop files, 62
disk drives, 62
files and folders, 62–63, 101–102, 304
man files, 391–392
network servers, 63
packages, 165–168, 291
recently-used documents, 63

Finger pain, 239
Firefox

bookmarking sites, 70
description, 68–70
Flash is missing, 198
Google searches, 70
Kubuntu, 309
lightweight alternative, 227
live bookmarks, 71
plug-ins, 71–72
previewing pages, 71
tabbed browsing, 70
Ubuntu/Windows equivalents, 420

Firewalls
Ekiga, 90
iptables command, 177–178
network security, 177–178

Firmware, licensing, 407–408
Flash disks. See USB storage devices, keyring

devices.
Flash is missing, 71, 198
Flight Simulator, 422
FlightGear, 422
Floppy disks, 131, 133
Folders. See also Files.

changing, 386
command-line interface to. See Terminal

commands, files and folders.
copying, 109–110
creating, 109, 387
current, identifying, 385–386
default, descriptions, 107
definition, 106
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Folders, continued
emblems, 111
files in, listing, 387
finding, 62–63, 101–102
hidden, 190–191
moving, 109–110
ownership, changing, 388
permissions, changing, 387
quick access, Kubuntu, 281
selecting, 110
tagging, 111
viewing, 109
working directory, printing, 385–386

Fonts
customizing, Kubuntu, 297
installed, checking for, 187
Kubuntu, 297
on LCD screen, 187–188
missing, 187
msttcorefonts package, 186
subpixel hinting, 187–188
TrueType, installing, 187
for Windows, 186–187
Windows applications, 186–187

Foreign language tutorials, 333
Formatting disks, 219–220
Forums. See Web forums.
Fraction exercises, 329
free command, 388
Free software

characteristics of, 4
freedoms, 4
history of Ubuntu

and the Debian project, 16–17
and GNU, 3

meaning of “free,” 6, 402
philosophical ideals, 402

FreeCell Solitaire, 97
Freedoms, 4
FreeNode IRC network, 246–247
Freespire distribution, 376
The Fridge, 253–254

fsck program, 229–230
F-Spot Photo Manager, 98, 133
Function graphing, 331

Gaim. See Pidgin.
Games, 96–97, 422
GCompris, 334
GCompris Administration, 327
General Tab, System Settings window, 296
Geographical location, specifying, 39–40, 48–49
Geometrical constructions, 330
GFS (Global File System), 150
GHNS (Get Hot New Stuff), 284–285
GIMP (GNU Image Manipulation Program)

creating an image, 79
cropping, 84
description, 79
effect filters, 82–83
layers, 83–84
starting, 79
templates, 79–80
text, 81–82
Ubuntu/Windows equivalents, 420

GIMP Image Editor, 133
GizmoProject, 421
Glom, 420
gNewSense distribution, 375–376
GNOME desktop, 58
GNOME Meeting. See Ekiga.
gnome-bluetooth package, 217
gnome-obex-server package, 217
Gnometris, 96
GNU, history of Ubuntu, 3
Gnucash, 421
Gnumeric, 419
Goals of

Edubuntu, 325
Ubuntu

accessibility to disabled users, 20
Bug #1, 24–25
bug fixes, 23
CoC (Code of Conduct), 20–22
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philosophical, 18–20
technical, 22–24

Ubuntu community governance, 259–260
Gobuntu, 30–31, 35, 373
Google searches, 70, 304
Gotangco, Jerome, 264
Governance goals, 259–260
Governance structures

Community Council, 242, 262–264
LoCos (local community teams), 261
MOTUs (Masters of the Universe), 261–262
SABDFL (self-appointed benevolent dictator

for life), 265–266
team councils, 260–261
teams, 260–261
Technical Board, 264–265
Ubunteros, 266–267
Ubuntu members, 266–267

Graphical interface fails to start, 185–186
Graphics. See Drawing; Image editing.
Graphing, 331
Grawert, Oliver, 325, 371
Green dragon, 273
grep command, 389. See also zgrep command.
grep tutorials, 389
Grisbi, 421
Ground rules for Ubuntu Community, 396–398.

See also Ubuntu foundation documents.
Groups, user accounts

adding/removing, 390
commands for, 390
Edubuntu, 362

Gtranslate. See Rosetta.
Guadalinex distribution, 374–375
Guided—Use Entire Disk and Set Up LVM

option, 51
Guided—Use Entire Disk option, 51
Gwenview, 319

HAL devices, listing, 389
Handicapped users. See Accessibility.
Hangman game, 329–330

Hard disks. See also Disk storage; LVM (Logical
Volume Manager).

copying files from USB devices, 132
fixing, 229–230
mounting/unmounting, 131
partitioning. See Partitioning disks.
usage analysis, 97
wiping before partitioning, 43–44

Hardware. See also specific devices.
detection during installation, 49
device filesystem, determining, 219
HAL devices, listing, 389
listing, 389
troubleshooting. See Troubleshooting,

hardware.
Hardy Heron 8.04 LTS, 3, 23
Harmony project, 273
Harrison, Eric, 325
Hash character (#), comment indicator, 163
HBD (Here Be Dragons), 8
Help. See also Online resources; Technical

support; Troubleshooting.
asking for, 397
for commands, 231
Edubuntu, 365–366
Kubuntu, 320–321
man pages

for commands, 231
finding, 391–392
Terminal, 143

Terminal, 143, 391–392
Ubuntu Help Center, 63

Help and support, 63
Hibernating, 68
Hidden files and folders, 108, 190–191
Hill, Benjamin Mako, 264
History of Ubuntu. See also Shuttleworth, Mark.

Debian project, 16–17
free software

and the Debian project, 16–17
and GNU, 3
meaning of “free,” 6
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History of Ubuntu, continued
GNU, 3
Linux, 5
open source, 5–7
Open Source Initiative, 6
Perens, Bruce, 6
Raymond, Eric S., 6
religious schisms, 6–7
Stallman, Richard M., 3
Torvalds, Linus, 5
user community, 17–18

Hoary Hedgehog, 148
Holbach, Daniel, 264
Home folder, 62
/home folder, 107
Home folder, Kubuntu default setup, 

303–304
/home partition, 151–152
Hostname, specifying, 46, 50
Hotmail, 75
HP device management, 298–299
HP Device Manager, 298–299
HP printer setup, 298
Hyphen (-), dash in commands, 141

i386 architecture, Ubuntu support, 34
IBM DB2 database, Ubuntu support, 26
ICQ, 421
IDE (Integrated Development Environment),

Kubuntu, 319
Ideas and feedback, 268
ifconfig command, 388
Illustrator, 422
Image editing. See also Drawing; GIMP (GNU

Image Manipulation Program).
GIMP Image Editor, 133

Image files. See .iso files.
Image viewer, Kubuntu, 319
Immutable desktop, Kubuntu, 316–317
Impress, 307–308, 419
Inkscape, 98–99, 422

Installation CDs
burning, 36–38, 132
buying, 36
mail order, 36

Installer, Kubuntu, 285
Installing

desktop environment, 188
desktop themes and backgrounds, 204
Kubuntu updates, 295–296
LIRC (Linux Infrared Control), 221–222
MythTV, 205–206
non-Synaptic applications, 189. See also

Autopackages.
remote control, 221–222
a server, 48
TrueType fonts, 187
visual themes, 204

Installing applications
with Add/Remove Applications, 120–122
application sources. See Repositories.
APT (Advanced Package Tool), 123
Kubuntu, 286
packages, 123
repositories, 123
software channels, 123. See also Repositories.
with Synaptic, 123–126

Installing Edubuntu
as an add-on, 326–327
dual booting, 347–349
with existing DHCP server, 345–346

Installing Kubuntu. See also Adept.
alongside Ubuntu, 275
from the desktop CD, 276–277
downloading the image file, 275
finding the right version, 275
switching from KDE3 to KDE4, 276
Ubiquity installer program, 276–277
updates. See Installing updates, Kubuntu.

Installing LTSP (Linux Terminal Server Project)
boot options, specifying, 347–349
client setup, 343–344

436 Index



clock, setting, 341–342
Dapper 6.06 LTS version, 343
DEFAULT keyword, 347–349
desktop installation, 344–345
DHCP servers, coexisting, 345–346
DHCP servers, installing, 345
DISPLAY option, 347–349
displaying a text file at startup, 347–349
dual boot, 347–349
installation procedure, 340–342
IP address, setting up, 341
keyboard, configuring, 340
language, specifying, 340
NICs (network interface cards), 338–340
prerequisites, 338
PROMPT option, 347–349
prompting to choose an operating system,

347–349
server configuration, 338–340
server setup, 342–343
switching from Ubuntu, 344
timeout delay, specifying, 347
TIMEOUT option, 347–349
in Ubuntu, 344–345
users, setting up, 342
UTC (Coordinated Universal Time), 341–342

Installing packages
with apt-get, 167
Kubuntu, 284–285, 291–293
manually, 164–165

Installing Ubuntu
checking for updates, 130
computer types supported, 34–35
filesystem default, 44–45
migrating from previous version, 46–47, 129–130
migration assistant, 46–47
Power PC support, 35
updates. See Installing updates, Ubuntu.

Installing Ubuntu from alternate install CD
definition, 34
geographical location specification, 48–49

getting the CD, 36–38
hardware detection, 49
hostname specification, 50
installing a server, 48
keyboard configuration, 49
language selection, 48
partitioning the disk

adding a partition, 52–53
Guided—Use Entire Disk and Set Up LVM

option, 51
Guided—Use Entire Disk option, 51
Manual option, 52
manually, 52–54
methods for, 51–54
organization options, 50–54
root partition, placing, 53
settings, 54

user configuration, 54
Installing Ubuntu from desktop CD

BIOS configuration problems, 38
definition, 34
failure to boot, 38
geographical location specification, 

39–40
getting the CD, 36–38
keyboard configuration, 41
language selection, 39–40
migrating from previous version, 

46–47
partitioning the disk

adding a partition, 44
definition, 41–45
for dual boot, 42–43, 43
manually, 43
methods for, 42–43
mount points, 45
sharing with Windows, 45
for Ubuntu only, 42, 43

password guidelines, 46
system use during installation, 47
user configuration, 45–46
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Installing Ubuntu Server
/home partition, 151–152
log file partition, 151–152
LVM (Logical Volume Manager). See also

RAID (redundant array of
inexpensive disks).

array management, 161
description, 156–157
fault tolerance, 160
LVs (logical volumes), 157–158
partitioning, 159
PEs (physical extents), 158
physical storage, moving, 158
PVs (physical volumes), 157–158
redundancy, 160
setting up, 158–159
VGs (volume groups), 158

mail spool partition, 151–152
partitioning, 151–152. See also RAID.
RAID (redundant array of inexpensive 

disks)
array failure, 156
array management, 161. See also LVM

(Logical Volume Manager).
backing up data, 155
choosing, 154
data replication, 153
degraded mode, 156
description, 152–153
fault tolerance, 153
levels, 153–154
modes, 154
parity drives, 154
physical drive failure, 156
RAID 0, 153
RAID 1, 153
RAID 5, 153
setting up, 154–156
spare devices, 156
striped set, 153

vs. regular Ubuntu machine, 149
root account, enabling, 160–161

scratch space, 151
software installer prompts, 160
software selection, 160
spool partition, 151–152
ssh client, 151
switching consoles, 151
/tmp partition, 151–152
user files, space for, 151
/var partition, 151–152

Installing updates
checking for, 196
failure, 194–195
Kubuntu

Adept update-notifier, 285
Adept Updater, 293–296
checking for, 296
filtering packages, 291–292
finding packages, 291
installing, 295–296
notification, 294, 296
red triangle in taskbar, 296
viewing package details, 292

new version of Ubuntu, 196
Ubuntu

checking for updates, 128–129, 130
launching the update, 127
limitations, 128–129
reviewing updates, 127–128
security-related, 126
smart updates, 129
Ubuntu releases, 129–130

Instant messaging
Kubuntu, 310–312
Pidgin, 86–87
Ubuntu/Windows equivalents, 421

Integrated Development Environment (IDE),
Kubuntu, 319

Intel Boot Agents will not boot, 364
Internet dial-up tool, 318
Internet Explorer, 420
Internet phone. See Ekiga.
Interrupting distribution upgrades, 169
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IP address, Edubuntu
changing, 352
not received, 363
setting up, 341

iPods, 115
iptables command, 177–178
ipvsadm utility, 150
IRC (Internet Relay Chat)

connecting to, 246
Edubuntu, 366
FreeNode IRC network, 246–247
Kubuntu, 312
list of channels, 247
Pidgin, 87
support for development releases, 247
Ubuntu, 87, 246–247

Isle of Man, 26
.iso files

burning to CD, 36–38, 132
definition, 36
testing, 191–192

iTunes, 420
iwconfig command, 388

Java not installed, 198–199
Joystick, Kubuntu, 297

K Control Center. See System Settings.
K3b program, 309–310
Kalach (bread), 237–238
Kalzium, 328
Kanagram, 329
Kate, 318
Kbabel. See Rosetta.
KBruch, 329
KDE desktop. See also Kubuntu.

current version, 273
customizing, 283–284, 297
GHNS (Get Hot New Stuff), 284–285
green dragon, 273
Harmony project, 273
history of, 272–273

Kdesktop. See Plasma.
Konqi, 273
locking, 316–317
making immutable, 316–317
mascot, 273
Plasma, 282–284
project Web site, 273
QPL (Q Public License), 273
QT toolkit, 273
switching from KDE3 to KDE4, 276

KDevelop, 319
KEduca, 329
KEduca-Editor, 329
keepalived utility, 150
Kernel

booting from wrong one, 184
Solaris, derived distribution, 377
for supercomputers, 149
version, updating, 357–359

Keyboard
layout

alternate install CD, 49
desktop CD, 41
Edubuntu, 340
Kubuntu, 297
Ubuntu, 41, 49

types garbage, 220–221
Keyring devices, 131–132
KHangman, 329–330
Kig, 330
Kiosk mode, 316–317
Kioslaves, 304
Kmail, 313–316
KMenu style, reverting to, 283
KmPlot, 331
Konqi, 273
Konqueror

browsing media files, 304
file manager, 304–305
finding files on your system, 304
Google searches, 304
kioslaves, 304
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Konqueror, continued
orange icon, 309
RSS feed indicator, 309
shortcuts, 304
Web browser, 308–309

Konqueror file manager, 304–305
Konsole, 318
Kontact, 312–316
Kopete, 310–312
KOrganizer, 314–315
KPDF, 319
KPercentage, 331
KPPP, 318
KRandRtray, 319
KRDC, 318–319
KRunner, 296
KSnapShot, 319
Ksplash, 297
KStars, 331–332
KSysGuard, 318
KSystemLog, 318
KTouch, 332, 422
KTurtle, 332–333
Kubuntu

applications
3D mapping, 319
Akregator, 315–316
automatic login, 320
Calc, 307–308
calculator, 318
calendars, 312–316
CDs, burning, 309–310
command-line interface, 318
common folders, quick access, 281
configuring, 277–281
Draw, 307–308
e-mail, 312–316
Excel equivalent, 307–308
Favorites list, 280
Gwenview, 319
IDE (Integrated Development 

Environment), 319

image viewer, 319
Impress, 307–308
instant messaging, 310–312
Internet dial-up tool, 318
IRC (Internet Relay Chat), 312
Kate, 318
KDevelop, 319
Kiosk mode, 316–317
Kmail, 313–316
Konsole, 318
Kontact, 312–316
Kopete, 310–312
KOrganizer, 314–315
KPDF, 319
KPPP, 318
KRandRtray, 319
KRDC, 318–319
KSnapShot, 319
KSysGuard, 318
KSystemLog, 318
Marble, 319
Math, 307–308
monitor configuration utility, 319
naming conventions, 280
Numlock activation, 320
Okular, 319
OpenOffice.org, 307–308
organization scheme, 280–281
PDF viewer, 319
performance monitor, 318
PIM (personal information manager),

312–316
PowerPoint equivalent, 307–308
presentations, 307–308
recently-used list, 281
remote desktop connection, 318–319
RSS feeds, tracking, 315–316
screen capture program, 319
screen configuration utility, 319
search program, 281
Speedcrunch, 318
spreadsheets, 307–308
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starting when Kubuntu starts, 319–320
system logs viewer, 318
text editor, 318
Word equivalent, 307–308
Word Processor, 307–308
Writer, 307–308

customizing. See also Kubuntu, customizing;
System settings, Kubuntu.

accessibility options, 297
audio CDs, 300
computer administration, 297–299
date and time, 297
desktop, 283–284, 297
digital cameras, 300
display, 297
file associations, 300
fonts, 297
GHNS (Get Hot New Stuff), 284–285
HP device management, 298–299
HP printer setup, 298
joystick, 297
keyboard, 297
KMenu style, reverting to, 283
ksplash, 297
language, 297
locking, 316–317
login, configuring, 300
look & feel, 297
making immutable, 316–317
MFDs (Multifunction Devices), 298
mouse, 297
notifications, 297
password, 297
personal information, 297
with Plasma, 282–284
power conservation, 298
printers, 298
regional, 297
screen orientation, 298
screen resolution, 298
screen savers, 284
sound, 297

splash screen, 297
startup services, configuring, 300
templates for, 284
widgets, 283
window behavior, 297

description, 371
desktop. See KDE desktop.
file management

browsing files, 304
burning CDs, 309–310
copying files, 304
deleting files, 304
Dolphin file manager, 302–303. See also

Konqueror.
file structure changes, 303–304
finding files, 304
home folder, default setup, 303–304
kioslaves, 304
Konqueror file manager, 304–305. See also

Dolphin.
music management, 306–307
USB drive access, 305
Windows partition access, 305–306
XDG Base Directory Specification,

303–304
XDG directories, 303–304

help, 320–321
history of, 274
installing. See Installing Kubuntu.
installing packages, 284–285, 291–293
introduction, 272
Kdesktop. See Plasma.
logging out, 281–282
packages. See also Adept package manager.

filtering, 291–292
finding, 291
installing, 284–285, 291–293
previewing details, 292

repositories, 288–291
root account, sudo instead of, 282
shutting down, 281–282
Start menu. See KMenu.
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Kubuntu, continued
switching sessions, 282
vs. Ubuntu, 35
usage statistics, 290–291
Web browsers, 308–309

Kubuntu, navigation
Application Launcher, 277–281
applications

common folders, quick access, 281
configuring, 277–281
Favorites list, 280
naming conventions, 280
organization scheme, 280–281
recently-used list, 281
Search Bar, 281
search program, 281

logging out, 281–282
shutting down, 281–282
sudo instead of root account, 282
switching sessions, 282

Kubuntu, system administration
device detection, 298–299
HP Device Manager, 298–299
Kynaptic. See Adept.
package management. See Adept package

manager.
printers, adding, 298–299
system settings. See also Kubuntu, customizing.

accessibility options, 297
audio CDs, 300
computer administration, 297–299
date and time, 297
desktop, 297
digital cameras, 300
display, 297
file associations, 300
fonts, 297
HP device management, 298–299
HP printer setup, 298
joystick, 297
keyboard, 297
ksplash, 297

language, 297
login, configuring, 300
look & feel, 297
MFDs (Multifunction Devices), 298
mouse, 297
notifications, 297
password, 297
personal information, 297
power conservation, 298
printers, 298
regional, 297
screen orientation, 298
screen resolution, 298
sound, 297
splash screen, 297
startup services, configuring, 300
window behavior, 297

System Settings window
Advanced tab, 300
Advanced User Settings, 300
Appearance section, 297
Computer Administration section, 297–299
Desktop section, 297
Display section, 298
General Tab, 296
HP Device Manager, 298–299
illustration, 297
location, 296
Login Manager, 300–301
Look & Feel section, 297
Network & Connectivity section, 296
Notifications section, 297
overview, 296
Personal section, 297
Power Control section, 298
returning to main screen, 296
Services section, 300
System section, 300
Window Behavior section, 297

updates
Adept update-notifier, 285
Adept Updater, 293–296
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checking for, 296
filtering packages, 291–292
finding packages, 291
installing, 295–296
notification, 294, 296
red triangle in taskbar, 296
viewing package details, 292

#kubuntu IRC channel, 247
#kubuntu-devel IRC channel, 247
Kverbos, 333
KVocTrain, 333

LAN (wired) can’t connect, 206–207
Language

changing, 102–103
specifying

for the desktop, 59
Edubuntu, 340
at installation, 39–40, 48
Kubuntu, 297

translating, 103
Launchpad

Answers, 28, 382–383
applications, writing and tracking, 

28
archive management, 379
Blueprint, 28, 381–382
bug tracking, 28, 380–381
components, 28
definition, 27
description, 27–29, 377–379
distribution management, 28, 379
feature tracking, 381–382
Malone, 28, 380–381
reported bugs, checking for, 236
reporting bugs, 235–236
Rosetta, 28, 379–380
Soyuz, 28, 379
specification tracking, 381–382
support tracking, 28
technical support tracking. See Answers;

Malone.

translation software, 28
translation system, 379–380

Layers, graphic, 83–84
LCD screens, font appearance, 187–188
LCoC (Leadership Code of Conduct)

conflicts of interest, 400
crediting achievements, 399
delegation, 399
leading by example, 399
overview, 398
personal interests vs. team interests, 400
respecting processes and principles, 399
stepping down, 400–401

Leading by example, 399
less command, 390. See also zless command.
/lib folder, 107
Licensing

code modifications, 407
default installation, 408
documentation, 407–408
drivers, 407–408
firmware, 407–408
latest version, 405
main component policy, 406–407
redistribution, 406
restricted component, 406–408
royalty payments, 407
software categories, 405–406
software requirements, 406–407

Linspire distribution, 376
Linux, in the history of Ubuntu, 5
Linux Documentation Project, 393
Linux Terminal Server Project (LTSP). See LTSP

(Linux Terminal Server Project).
Linux User Groups (LUGs). See LoCos (local

community teams).
Linux Virtual Server utility, 150
LinuxCommand.org, 393
LIRC (Linux Infrared Control)

for computer remote control, 221–222
installing, 221–222
for MythTV remote control, 205
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Listing files
by folder, 139–140, 387
with the ls command, 139–140
by package, 171

Live bookmarks, 71
Local devices, LTSP, 352–353
Local printers, 134–137
Localization, user involvement, 269
Lockdown editor, 361–362
Locking

Kubuntu desktop, 316–317
root account, 232
screens, 67, 361

LoCos (local community teams), 261
Log file partition, 151–152
Log files

partitioning for, 151–152
printing last ten lines, 177
reviewing, 177
security issues, 176
tail utility, 177
tools for, 177
Ubuntu Server, 176–177
zcat command, 177
zgrep command, 177
zless command, 177

Logging in
automatically, 194, 320
configuring, 300
Kubuntu, 300, 320
restarting, 68

Logging out
Edubuntu, 360
ending current session, 67
hibernating, 68
Kubuntu, 281–282, 298
locking the screen, 67
shutting down, 68
suspending power, 67, 298
switching users, 67
Ubuntu, 67

Logical Volume Manager (LVM). See LVM
(Logical Volume Manager).

Logical volumes (LVs), 157–158
Login Manager, System Settings window,

300–301
Logo programming language, 332–333
Long Term Support (LTS), 130
Look & feel, customizing, 297
Look & Feel section, System Settings window,

297
ls command, 139–140, 387
lsb_release -a command, 388
lshal command, 389
lshw command, 389
lspci command, 389
lsusb command, 389
LTS (Long Term Support), 130
LTSP (Linux Terminal Server Project). See also

Edubuntu.
applications, adding/removing, 350–351
availability, 337
benefits of, 336–337
boot process, technical details, 335–336
client setup, 343–344
definition, 334
description, 334–336
diskless clients, 334
dual booting, 347–349
installing. See Installing LTSP (Linux

Terminal Server Project).
Intel Boot Agents will not boot, 364
IP address, changing, 352
IP address not received, 363
local devices, 352–353
NFS server not responding, 363–364
password display, 352
printing, 354–355
server setup

installing applications, 350–351
IP address, changing, 352
local devices, 352–353
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password display, 352
printing, 354–355
removing applications, 351
sound, 353–354
SSH keys, updating, 352
updating the server, 349
window manager alternatives, 355–356

sound, 353–354
SSH keys, updating, 352
thin clients, 337
troubleshooting, 363–364
updating the server, 349
USB sticks, 352–353
VMWare client crashes while booting, 364
window manager alternatives, 355–356

LUGs (Linux User Groups). See LoCos (local
community teams).

LVM (Logical Volume Manager)
array management, 161
description, 156–157
fault tolerance, 160
LVs (logical volumes), 157–158
partitioning, 159
PEs (physical extents), 158
physical storage, moving, 158
PVs (physical volumes), 157–158
redundancy, 160
setting up, 158–159
VGs (volume groups), 158

LVs (logical volumes), 157–158

Macromedia Flash is missing, 71, 198
Mahjongg, 96
Mail order installation CDs, 36
Mail spool partition, 151–152
Mailing lists

available, list of, 244
CoC (Code of Conduct), 398
daily digests, 244–245
Edubuntu related, 365–366
edubuntu-devel, 366

edubuntu-users, 366
Mailman software, 244
sending messages to, 244
sounder, 246
Ubuntu related, 244–246
ubuntu-announce, 245
ubuntu-devel, 245
ubuntu-devel-announce, 245
ubuntu-devel-discuss, 245
ubuntu-users, 245, 250

Mailman software, 244
Main component, 403, 406–407
Main repository, 162
Main repository, Kubuntu, 288
Making a call, Ekiga, 93–94
Malicious packages, 164–165
Malone, 24–25, 28, 380–381
man command, 391–392
Man pages. See also Help.

for commands, 231
finding, 391–392
Terminal, 143

Manual option, 52
Mapping program, 319
Marble, 319
Mascot, KDE, 273
Masters of the Universe (MOTUs), 261–262
Math applications

factoring numbers, 329
fraction exercises, 329
function graphing, 331
geometrical constructions, 330
KBruch, 329
Kig, 330
KmPlot, 331
KPercentage, 331
percentage exercises, 331

Math program, 307–308
Mauelshagen, Heinz, 157
Mavis Beacon Teaches Typing, 422
Maximizing applications, 60

Index 445



Maya, 422
MBR (master boot record), 228. See also Boot

sector.
McNealy, Scott, 179
Media file won’t play, 200–201
Media files, browsing, 304
/media folder, 107
Media players, Ubuntu/Windows equivalents,

420
Meetings. See Calendars.
Memory

errors, 217
memtest utility, 217
out of, 217
troubleshooting, 184
usage, displaying, 388

memtest utility, 217
Menu layout, customizing, 61–62
Meritocracy, 259
MFDs (Multifunction Devices), 298
Microphone doesn’t work, 202–203
Migrating from previous version, 46–47,

129–130. See also Installing updates.
Migration assistant, 46–47
Minimizing applications, 60
mkdir command, 387
mkfs commands, 220
/mnt folder, 107
Mobile phone, copying photos from, 217
Modeling, Ubuntu/Windows equivalents, 

422
Money, 421
Monitors. See also Screens.

fonts on LCD screens, 187–188
Kubuntu

configuration utility, 319
customizing, 297
resizing, 319
rotating, 319

screen resolution, changing, 194
subpixel hinting, 187–188

MOTUs (Masters of the Universe), 261–262

Mounting/unmounting drives, 131
Mouse

customizing, Kubuntu, 297
doesn’t work, 221
scroll wheel, enabling, 221
troubleshooting, 221

Movie Player, 97
Movies. See Video.
Moving files and folders, 109–110, 387
MP3 format, 115
msttcorefonts package, 186
Muine, 420
Multifunction Devices (MFDs), 298
Multimedia. See also Audio; Music; Video.

codecs, installing, 111–113
compression, 111–113
media file won’t play, 200–201
media files, browsing, 304
troubleshooting. See Troubleshooting,

multimedia.
Multiprocessor performance, 149
Multiverse component, 405
Multiverse repository, 162
Multiverse repository, Kubuntu, 288
Music, 306–307. See also Audio; Multimedia.
mv command, 387
My Computer, Ubuntu equivalent, 62
Mythbuntu, 206
MythTV, 205–206

Naming conventions, Kubuntu applications, 
280

nano command, 390
nano text editor, 390
Nautilus

configuration files, 108
emblems, 111
folders, 107
scripting, 197–198
sidebar, 110–111
starting, 108
storing and organizing files, 106–107
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Network & Connectivity section, System Settings
window, 296

Network interface cards (NICs), 338–340
Network interface report, 388
Network Neighborhood, Ubuntu equivalent, 

63
Network option, 63
Networks

device support, determining, 206
file transfer, 207–208
firewalls, 177–178
interface report, 388
iptables command, 177–178
printers, 134–137
remote graphical applications, 208–209
servers, 63
SSH (Secure Shell), 207–209
troubleshooting. See Troubleshooting,

networking.
Ubuntu Server, 177–178
Web site not loading, 207
wired LAN can’t connect, 206–207
wireless card not working, 209–210
wireless information, displaying, 388
WPA support, 211
WPA-PSK support, 211

New Printer Wizard, 135–137
Nexenta OS distribution, 377
NFS root, updating, 356–357
NFS server not responding, 363–364
Nibbles, 96
NICs (network interface cards), 338–340
noatime option, 175
nodev option, 174
noexec option, 174
nosuid option, 174
Notification area, 65
Notification of updates, Kubuntu, 294, 296–297
Notifications section, System Settings window,

297
NUMA, Ubuntu Server, 149
Numlock activation, Kubuntu, 320

OCFS2 filesystem, Ubuntu Server, 150
Office software, Ubuntu/Windows equivalents,

421–422. See also OpenOffice.org.
Official support, 162
Ogg format, 115
Ogg Theora, 112
Ogg Vorbis, 112
Okular, 319
Older computers, running Ubuntu, 226–227. See

also Ubuntulite; Xubuntu.
Omma, Henrik, 377
Online resources. See also Help.

announcements, 245
bulletin boards. See IRC (Internet Relay

Chat); Mailing lists; Wikis.
desktop themes and backgrounds, 204
development discussions. See Blogs; IRC (Internet

Relay Chat); Mailing lists; Wikis.
Edubuntu, 365–366
The Fridge, 253–254
grep tutorials, 389
IRC (Internet Relay Chat), 246–247
KDE desktop, project Web site, 273
Kubuntu forums, 321
Kubuntu image files, 275
Kubuntu wiki, 321
Linux Documentation Project, 393
LinuxCommand.org, 393
LVM array management, 161
mailing lists, 244–246
Mythbuntu, 206
MythTV, 206
Planet Ubuntu, 71
Planet Ubuntu blogs, 258–259
RAID array management, 161
sed tutorials, 389
Terminal commands, 393
Ubuntu developer blogs, 71
Ubuntu forums, 180
Ubuntu Server, 180
Web forums, 248–250
wikis, 250–253
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Open CD distribution, 377
Open source

history of Ubuntu, 5–7
philosophical ideals, 402

Open Source Initiative, 6
OpenOffice.org

creating documents, 72–74
drawing. See Draw.
Kubuntu, 307–308
lightweight alternative, 227
mathematical expression builder. See Math.
presentations. See Impress.
spreadsheets. See Calc.
word processing. See Writer.

/opt folder, 107
Orange icon, Konqueror, 309
Orbiter, 422
Orphan packages, removing, 171
Outlook, 420
Outlook Express, 420
Ownership, files

changing, 388
finding, 171

Package management. See also Synaptic;
Ubuntu archive.

MOTUs (Masters of the Universe), 
261–262

Technical Board, 265
Ubuntu Server. See Ubuntu Server, package

management.
Packages

definition, 123
details, viewing, 292
finding, 125–126
information, displaying, 166–167
installing

with Add/Remove Applications, 120–122
with Synaptic, 123–125

Kubuntu. See also Adept package manager.
filtering, 291–292
finding, 291

previewing details, 292
processes and standards, 264
removing, 125
user community maintainers, 261–262, 265

Packaging, user involvement, 269–270
Panel, 59
Parity drives, RAID, 154
Partitioning disks

alternate install CD
adding a partition, 52–53
Guided—Use Entire Disk and Set Up LVM

option, 51
Guided—Use Entire Disk option, 51
Manual option, 52
manually, 52–54
methods for, 51–54
organization options, 50–54
partition settings, 54
root partition, placing, 53
settings, 54

desktop CD
adding a partition, 44
definition, 41
for dual boot, 42–43, 43
manually, 43
methods for, 42–43
mount points, 45
sharing with Windows, 45
for Ubuntu only, 42, 43
wiping the disk, 43–44

/home partition, 151–152
installing Ubuntu Server, 151–152
log files, 151–152
LVM (Logical Volume Manager), 159
mail spools, 151–152
scratch space, 151–152
security, 151–152
/tmp partition, 151–152
Ubuntu Server, 151–152
user files, space for, 151–152
/var partition, 151–152
for Windows, 144–145
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Partner projects. See Ubuntu editions.
passwd command, 390
Passwords. See also Security.

Administration features, 63
for Administration features, 63
changing, 390
customizing, 297
displaying, 352
guidelines, 46
keyring, 139
for new user accounts, 46
recovering, 232–233
restoring a root account, 232
setting up, 46, 297
SSH file transfer, 208–209
storing, 139
unlocking screensavers, 105

PCI buses, listing, 389
PDF files, creating with OpenOffice.org, 74
PDF viewer, 319
Pen disks. See USB storage devices, keyring

devices.
Percentage exercises, 331
Perens, Bruce, 6
Performance

desktop, 226–227
File Manager, 190
monitoring, 97, 318
system, analyzing, 230–231

Periodic table exploration, 328
Permissions

files, changing, 387
security issues, 174
USB storage devices, 218

Personal accounting, Ubuntu/Windows
equivalents, 421

Personal information, Kubuntu, 297
Personal interests vs. team interests, 400
Personal section, System Settings window, 

297
PEs (physical extents), 158
Pessulus lockdown editor, 361–362

Philosophical ideals
core ideals, 401
free software, 402
open source, 402
overview, 18–20, 401

Photo editors, Ubuntu/Windows equivalents,
420

Photograph management, 98
Photographs

copying from mobile phone, 217
editing. See Image editing.

Photoshop, 420
Physical storage, moving. See LVM (Logical

Volume Manager).
Physical volumes (PVs), 157–158
Pictures. See Drawing; Image editing;

Photographs.
Pidgin

Buddies menu, 87
description, 85
instant messaging, 86–87, 421
IRC (Internet Relay Chat), 87
setting up accounts, 85–86

PIM (personal information manager), 312–316
Pipelines, 140, 142, 393
Places menu, 61–63
Planet Ubuntu, 71, 258–259
Planetarium, Ubuntu/Windows equivalents,

422
Planner, 422
Plasma, 282–284
Playing CDs, 115
Plug-ins, Edubuntu, 362
Podcasts, 113
Power, electrical. See Electrical power.
Power Control section, System Settings window,

298
Power PC support, 35
PowerPoint

fonts look wrong, 186–187
Kubuntu equivalent, 307–308
Ubuntu/Windows equivalents, 419
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A Practical Guide to Linux® Commands..., 393
Preferences. See Configuring; Customizing;

System settings.
Prentice Hall, Ubuntu support, 26
Presentation programs

Kubuntu, 307–308
Ubuntu/Windows equivalents, 419

Previewing update changes, 292–293
Printers

configuring, 133–137
description, specifying, 136–137
detecting, 298–299
driver, specifying, 136
drivers, 136
gathering information, 135
HP device management, 298–299
HP Device Manager, 298–299
HP printer setup, 298
Kubuntu, 298–299
local, 134–137
location, specifying, 136–137
manufacturer, choosing, 136
model, specifying, 136
network, 134–137
New Printer Wizard, 135–137
remote printing, 138

Printing
all system information, 388
last ten log lines, 177
LTSP, 354–355
remotely, 138
version information, 388
working directory, 385–386

Problem reporting, 63
Problems, solving. See Troubleshooting.
Processes

information, displaying, 388
viewing, 389

/proc/sys folder, 107
Production studio, 98–99
Programming, user involvement, 269–270

Programs. See specific programs.
application. See Applications.
operating systems. See specific operating

systems.
Project, 422
Project management, Ubuntu/Windows

equivalents, 422
Project technical direction, setting, 264–265
PROMPT option, 347–349
Prompting to choose an operating system, 347–349
ps command, 389
Publisher, 421
pulseaudio, 202
PVs (physical volumes), 157–158
pwd command, 385–386
Python programming language, 24

QEMU project, 234
QPL (Q Public License), 273
QT toolkit, 273
Quality assurance, user involvement, 269
Question mark (?), wildcard character, 392
Quickbooks, 421
Quicken, 421

RAID (redundant array of inexpensive disks)
array failure, 156
array management, 161
backing up data, 155
choosing, 154
data replication, 153
degraded mode, 156
description, 152–153
fault tolerance, 153
levels, 153–154
modes, 154
parity drives, 154
physical drive failure, 156
RAID 0, 153
RAID 1, 153
RAID 5, 153
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setting up, 154–156
spare devices, 156
striped set, 153

RAID 0, 153
RAID 1, 153
RAID 5, 153
Raymond, Eric S., 6
Recent Documents option, 63
Recently-used list, 281
Recording sound, 97
Recovery mode, 183–184
Red Hat Cluster Suite, Ubuntu Server, 150
Red triangle in taskbar, 296
Redistribution, licensing, 406
Redundancy, LVM, 160
Redundant array of inexpensive disks (RAID).

See RAID (redundant array of
inexpensive disks).

Regional settings, Kubuntu, 297
Releases. See also specific releases.

Feature Freeze, 264–265
feature goals, setting, 264–265
schedule of, 22–23
support limitations, 23

Religious schisms, 6–7
Reminders. See Calendars.
Remote control

computer, 221–222
installing, 221–222
MythTV, 205
troubleshooting, 221–222

Remote desktop connection, 318–319
Remote printing, 138
Remote terminal server, connecting to, 96
Removing. See also Deleting.

packages
with apt-get, 167
orphans, 171

programs
Adept package manager, 286
Edubuntu, 350–351

Kubuntu, 286
LTSP, 350–351
Ubuntu, 120–122

user accounts, 390
user groups, 390

Rendering, 98–99
Repetitive strain injury (RSI), 239
Repositories. See also Ubuntu archive.

Backports, 162
definition, 123
history of, 14–16
Kubuntu

main, 288
managing, 288–291
multiverse, 288
restricted, 288
third-party, 289–290
universe, 288

local copy of, 189
Main, 162
Multiverse, 162
Restricted, 162
Ubuntu archive, 162
Universe, 162

Rescue mode, 183–184
Resolution, screen

changing, 194
Edubuntu, 342
Kubuntu, 298

Resource information, displaying, 388
Respect for others, 396
Respecting processes and principles, 399
Restoring

boot sector, 183–184
deleted items, 190–191

Restricted component
description, 404
licensing policy, 406–407
purpose, 408

Restricted drivers, 186
Restricted repository, 162
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Restricted repository, 288
Reviewing

log files, 177
updates, 127–128

Revision control system, 384
Rhythmbox, 113, 420
Riddell, Jonathan, 272, 274, 371
Ripping CDs, 97, 115
rm command, 387
Root account

disabling, 232
enabling, Ubuntu Server, 160–161
Kubuntu, 282
locking, 232
preventing automatic login, 194
restoring, 231–232
sudo instead of, Kubuntu, 282

/root folder, 107
Root partition, placing, 53
Rosetta, 28, 379–380
Royalty payments, licensing, 407
RSI (repetitive strain injury), 239
RSS feeds, Kubuntu

availability indicator, Konqueror, 309
tracking, 315–316

rsync process, 189
Running as superuser, 142–143

SABDFL (self-appointed benevolent dictator
for life), 265–266

/sbin folder, 107
Scalable Vector Graphics (SVG), 98–99
Scheduling events, 223–225. See also Calendars.
Schools, Ubuntu for. See Edubuntu.
Schwartz, Jonathan, 179
scp command, 226
Scratch space, partitioning for, 151–152
Screen capture program, 319
Screen savers

configuring, 104–105
customizing, Kubuntu, 284
passwords, 105

Screens. See also Monitors.
Edubuntu

blanking, 361
locking, 361
resolution, 342

Kubuntu
configuration utility, 319
customizing, 297
orientation, customizing, 298
resolution, customizing, 298

resolution, changing, 194
Scribus, 421
Scripting

File Manager, 197–198
Nautilus, 197–198

Scroll wheel, enabling, 221
Search Bar, 281
Search for Files option, 63
Search tools. See also Finding.

Adept package manager, 287, 291
Beagle, 100
Firefox, 70
Google search, Kubuntu, 304
Google searches, 70
Konqueror, 304
Kubuntu, 281, 287, 291
Search Bar, 281

Secure Shell (SSH), 207–209
Security. See also Passwords.

device file creation, disabling, 174
Firefox plug-ins, 72
permissions, 387
root, preventing automatic login, 194
Ubuntu Server

access permissions, 174
device file creation, disabling, 174
file access record, disabling, 175
file execution, disabling, 174
filesystems, 174–175
iptables command, 177–178
log files, 176
networking, 177–178
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noatime option, 175
nodev option, 174
noexec option, 174
nosuid option, 174
overview, 172
partitioning, 151–152
system log files, 176–177
system resource limits, 175–176
third-party packages, 164–165
user account administration, 172–174

Security-related updates, 126
sed (Stream EDitor), 389
sed command, 389
Selecting files and folders, 110
Self-appointed benevolent dictator for life

(SABDFL), 265–266
Semicolon (;), running multiple commands,

225
Sending messages, Edubuntu, 361
Serial mouse doesn’t work, 221
Serpentine, 132
Server management, Edubuntu. See also LTSP

(Linux Terminal Server Project).
adding/removing programs, 350–351
installing applications, 350–351
IP address, changing, 352
local devices over LTSP, 352–353
password display, 352
printing, 354–355
sound, 353–354
SSH keys, updating, 352
updating the server, 349
USB sticks under LTSP, 352–353
window manager alternatives, 355–356

Servers vs. desktops, 23. See also Ubuntu Server.
Service and support. See Technical support.
Services section, System Settings window, 300
Shortcut icons, 64
Shortcuts, Konqueror, 304
Shutting down, 68, 281–282
Shuttleworth, Mark. See also History of

Ubuntu.

Canonical Ltd.
Bazaar tool, 27
formation of, 11–12
Launchpad, 27–29, 378
service and support, 26–27

Community Council member, 264
HBD (Here Be Dragons), 8
profile, 7–8
SABDFL (self-appointed benevolent dictator

for life), 265–266
space travel, 8
Thawte, 8
TSF (The Shuttleworth Foundation), 8
Ubuntu as a meritocracy, 259
Ubuntu Foundation, 29
Ubuntu Server on Sun hardware, 179
Verisign, 8
the Warthogs, 2–3, 9–10

The Shuttleworth Foundation (TSF), 8
Sidebar, Nautilus, 110–111
SIP protocol, Ekiga, 87–89
Skolelinux team, 325
Skype, 421
Slackware, 14
SLS (Softlanding Linux System), 14
Smart updates, 129
SMP (symmetric multiprocessing), Ubuntu

Server, 149
Sobell, Mark G., 393
Software categories, licensing, 405–406
Software channels, 123
Software stores. See Repositories.
Software upgrades. See Installing updates.
Solaris kernel. See Nexenta OS.
Sound. See Audio; Music.
Sound cards

configuring, 65
list of, 212–213
not detected, 211–213

Sound Juicer, 115
Sound Recorder, 97
Sound server, 202
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Sounder mailing list, 246
Soyuz, 28, 379
Space simulator, Ubuntu/Windows equivalents,

422
Space travel, 8
Spanish language distribution, 374–375
Spanish language tutorial, 333
Spare RAID devices, 156
Specification tracking, 381–382
Speedcrunch, 318
Spelling exercise, 329–330
Spillner, Josef, 284
Splash screen

customizing, 297
disabling, 185

Spool partition, Ubuntu Server, 151–152
Spreadsheets

Kubuntu, 307–308
lightweight alternative, 227
Ubuntu/Windows equivalents, 419

Sprints, 254–256
SSH (Secure Shell), 207–209
ssh client, Ubuntu Server, 151
SSH keys, updating, 352
Stallman, Richard M.

gNewSense, 373
Gobuntu, 371
history of Ubuntu, 3

Standard release support, 162
Starry Night, 422
Stars database, 331–332
Startup services, configuring, 300
Stellarium, 422
Stepping down, 397–398, 400–401
Stick disks. See USB storage devices, keyring

devices.
Storage, physically moving. See LVM (Logical

Volume Manager).
Stream EDitor (sed), 389
Striped RAID set, 153
Student Control Panel. See Thin Client

Manager.

Subpixel hinting, 187–188
sudo command

access to superuser account, 143
instead of root account, 282
restoring a root account, 231–232
shortcut, 231–232

Sudoku, 97
Summits, 254–256
Sun hardware, Ubuntu Server support, 179
Supercomputers, support for, 149
Superuser, running commands as, 142–143
Support. See Technical support.
Suspending electrical power, 67, 298
SVG (Scalable Vector Graphics), 98–99
Switching

applications, 65–66
consoles, 151
sessions, 282
users, 67

Symmetric multiprocessing (SMP), Ubuntu
Server, 149

Synaptic
can’t find an application, 189, 226. See also

Autopackages.
checking for updates, 128–129
installing packages and applications, 123–126
name origin, 123

System administration
customizing your system. See System settings.
Kubuntu. See Kubuntu, system administration.
troubleshooting. See Troubleshooting, system

administration.
System configuration, 63
System information

command-line interface to. See Terminal
commands, system information.

printing, 388
System logs viewer, 318
System menu, 61, 63
System Monitor, 97
System problems, troubleshooting. See

Troubleshooting, system problems.
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System resource limits, 175–176
System section, System Settings window, 

300
System settings, Kubuntu

accessibility options, 297
audio CDs, 300
computer administration, 297–299
date and time, 297
desktop, 297
digital cameras, 300
display, 297
file associations, 300
fonts, 297
HP device management, 298–299
HP printer setup, 298
joystick, 297
keyboard, 297
ksplash, 297
language, 297
login, configuring, 300
look & feel, 297
MFDs (Multifunction Devices), 298
mouse, 297
notifications, 297
password, 297
personal information, 297
power conservation, 298
printers, 298
regional, 297
screen orientation, 298
screen resolution, 298
sound, 297
splash screen, 297
startup services, configuring, 300
window behavior, 297

System Settings window
Advanced tab, 300
Advanced User Settings, 300
Appearance section, 297
Computer Administration section, 

297–299
Desktop section, 297

Display section, 298
General Tab, 296
HP Device Manager, 298–299
illustration, 297
location, 296
Login Manager, 300–301
Look & Feel section, 297
Network & Connectivity section, 296
Notifications section, 297
overview, 296
Personal section, 297
Power Control section, 298
returning to main screen, 296
Services section, 300
System section, 300
Window Behavior section, 297

System tray, Ubuntu equivalent, 65

Tabbed browsing, 70
Tagging files and folders, 111
tail utility, 177
Taskbar, 60, 65–66
Team councils, 260–261
Teams, 260–261, 263
Technical Board, 264–265
Technical goals of Ubuntu, 22–24
Technical support

See also Bugs, tracking
See also Help
See also Online resources
See also Troubleshooting
See also Ubuntu community, communication

venues
Answers, 28, 382–383
Canonical Ltd., 26–27
development releases, 247
limitations, 23, 130
LTS (Long Term Support), 130
official support, definition, 162
standard release support duration, 162
tracking, 28, 382–383
user involvement, 267–268
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Templates
for customizing, Kubuntu, 284
GIMP, 79–80
graphic, 79–80

Terminal
definition, 96
description, 139–143
help, 143, 391
lightweight alternative, 227
man files, searching for, 391–392
man pages, 143, 391
opening a command-line interface, 96,

140–141
starting, 385
xterm alternative, 227

Terminal commands
* (asterisk), wildcard character, 392
- (hyphen), dash in commands, 141
? (question mark), wildcard character, 392
| (vertical bar), pipe symbol, 393
| (vertical bar), pipeline symbol, 140
[ ] (brackets), wildcard characters, 392
[! ] (brackets, exclamation point), wildcard

characters, 392
~ (tilde), home directory indicator, 141
addgroup, 390
adduser, 390
delgroup, 390
deluser, 390
documentation. See Man pages.
filesystem navigation, 385–386
help, 391
listing files, 139–140
ls, 139–140
man, 391–392
man pages, accessing, 391–392
online resources, 393
passing output. See Pipelines.
passwd, 390
passwords, changing, 390
pipelines, 140, 142, 393
A Practical Guide to Linux® Commands..., 393

running as superuser, 142–143
running sequentially, 392–393
stringing together. See Pipelines.
sudo, 143
user accounts, adding/removing, 390
for users and groups, 390
users logged on, displaying, 390
who, 390
wildcards, 392

Terminal commands, files and folders
cat, 390
cd, 386
chmod, 387
chown, 388
cp, 387
directories

changing, 386
creating, 387
current, identifying, 385–386
files in, listing, 387
working, printing, 385–386

files
copying, 387
deleting, 387
listing, 387
moving, 387
ownership, changing, 388
permissions, changing, 387
text, concatenating, 390
text, searching and editing, 389–390

grep, 389
less, 390
ls, 387
mkdir, 387
mv, 387
nano, 390
pwd, 385–386
rm, 387
sed, 389

Terminal commands, system information
df, 388
disk space usage, displaying, 388
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free, 388
HAL devices, listing, 389
hardware, listing, 389
ifconfig, 388
iwconfig, 388
lsb_release -a, 388
lshal, 389
lshw, 389
lspci, 389
lsusb, 389
memory usage, displaying, 388
network interface report, 388
PCI buses, listing, 389
printing, 388
process information, displaying, 388
processes, viewing, 389
ps, 389
resource information, displaying, 388
top, 388
uname -a, 388
USB buses, listing, 389
version information, printing, 388
wireless network information, displaying,

388
Test creation and administration, 329
Text, graphics, 81–82
Text chat, 95
Text Editor, 95
Text editors

Kate, 318
Kubuntu, 318
nano, 390
sed (Stream EDitor), 389
Text Editor, 95

Text files
concatenating, 390
searching and editing, 389–390

Thawte, 8
The Shuttleworth Foundation (TSF), 8
Themes. See also Background, desktop.

changing, 203–204
configuring, 104–105

finding, 204
installing, 204
online source for, 204

Thin Client Manager, 359–360
Thin clients, 337
Third-party repositories, 289–290
3D mapping, Kubuntu, 319
3D modeling, 98–99, 422
Thunderbird, 420
Tilde (~), home directory indicator, 141, 165
Time and date. See Clock; Date and time.
Timeout delay, specifying, 347
TIMEOUT option, 347–349
/tmp partition, 151–152
top command, 231, 388
Torvalds, Linus, 5
Totem Movie Player, 115–116, 420
Touch typing tutorial, 332
Tracking bugs. See Bugs, tracking; Launchpad;

Malone.
Translation, user involvement, 269
Translation software, 28
Translation system, 379–380
Trash

emptying, 66
recovering deleted items, 190–191

Troubleshooting. See also Technical support.
applications

e-mail address, configuring, 199
e-mail doesn’t work, 199–200
Evolution, e-mail doesn’t work, 199–200
File Manager, scripting, 197–198
Firefox, Macromedia Flash is missing, 198
Java not installed, 198–199
Macromedia Flash is missing, 71, 198
Nautilus, scripting, 197–198
program won’t close, 196
sound doesn’t play, 202
upgrade notification, disabling, 197
window won’t close, 196

BIOS configuration problems, 38
DVD encryption, 117
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Troubleshooting, continued
e-mail server, unable to connect to, 77
finger pain, 239
installation CD fails to boot, 38
LTSP

Intel Boot Agents will not boot, 364
IP address not received, 363
NFS server not responding, 363–364
VMWare client crashes while booting, 

364
networking

device support, determining, 206
file transfer, 207–208
remote graphical applications, 208–209
SSH (Secure Shell), 207–209
Web site not loading, 207
wired LAN can’t connect, 206–207
wireless card not working, 209–210
WPA support, 211
WPA-PSK support, 211

problem reporting, 63
RAID array failure, 156
RSI (repetitive strain injury), 239
system administration

bug reports, filing, 234–237
copying files between computers, 

225–226
desktop, speeding up, 226–227
Desktop Effects, disabling, 226
disk space, reducing, 230
disk storage, recovering from power

failure, 229–230
fixing hard disks, 229–230
fsck program, 229–230
help for commands, 231
man pages for commands, 231
password recovery, 232–233
performance analysis, 230–231
root account, restoring, 231–232
scheduling events, 223–225. See also Cron;

Crontab.
slow computer, analyzing, 230–231

sudo command, shortcut, 231
Synaptic can’t find an application, 189,

226. See also Autopackages.
top command, 231
Ubuntu on older computer, 226–227
Ubuntu won’t start after Windows

reinstall, 228–229
users, adding, 233
Windows partition access, 233

Troubleshooting, hardware
Bluetooth, copying photos from mobile

phone, 217
cardbus adapter not recognized, 213–214
CD/ROM not working, 216
CD/ROM won’t eject, 216
copying photos from mobile phone, 217
device doesn’t work, 216–217
device support, determining, 222
disk storage. See also USB storage.

fixing, 229–230
formatting, 219–220
fsck program, 229–230
reads but won’t write, 218–219
recovering from power failure, 229–230

DVD not working, 216
DVD won’t eject, 216
filesystem

creating, 220
determining, 219
hardware issues, 218–219

keyboard types garbage, 220–221
LIRC (Linux Infrared Control)

for computer remote control, 221–222
installing, 221–222
for MythTV remote control, 205

memory errors, 217
memtest utility, 217
mkfs commands, 220
mobile phone, copying photos from, 217
mouse doesn’t work, 221
mouse scroll wheel doesn’t work, 221
out of memory, 217
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remote control for
computer, 221–222
MythTV, 205

serial mouse doesn’t work, 221
sound card not detected, 211–213
sound cards, list of, 212–213
Ubuntu compatibility, determining, 222
USB storage. See also Disk storage.

files copied to missing, 215–216
not recognized, 214–215
reads but won’t write, 217–219

Troubleshooting, multimedia
applications, sound won’t play, 202
desktop themes and backgrounds

changing, 203–204
finding, 204
installing, 204
online source for, 204

DMA (direct memory access mode),
enabling, 201

DMCA (Digital Millennium Copyright Act),
200–201

DVD playback is jittery, 201
DVD won’t play, 201
media file won’t play, 200–201
microphone doesn’t work, 202–203
MythTV, installing, 205–206
remote control, MythTV, 205
restricted formats, 200
sound distortion, 203
sound server conflict, 202
visual themes and backgrounds. See

Background, desktop; Themes.
Troubleshooting, system problems

applications
compiling, 192–193
non-Synaptic, installing, 189
required tools, verifying, 193

automatic login, 194
Autopackages, running, 192
boot failure, 183–184
boot logo appears corrupted, 184–185

boot sector, backing up and restoring, 183–184
bootloader, 183–184
compiling applications, 192–193
debmirror process, 189
desktop

adding TrueType fonts, 187
hung, 194
installing a new environment, 188

disk space, freeing up, 195
Disk Usage Analyzer, 195
dual boot environment, 233–234
File Manager

displaying hidden files and folders,
190–191

freeing disk space, 195–196
restoring deleted items, 190–191
speeding up, 190
viewing freed disk space, 195–196

fonts
installed, checking for, 187
on LCD screen, 187–188
subpixel hinting, 187–188
TrueType, installing, 187
Windows applications, 186–187

graphical interface fails to start, 185–186
.iso files, testing, 191–192
login automatically, 194
memory problems, 184
non-Synaptic application, installing, 189. See

also Autopackages.
PowerPoint fonts look wrong, 186–187
recovery mode, 183–184
repositories, local copy of, 189
rescue mode, 183–184
restricted drivers, 186
root, preventing automatic login, 194
rsync process, 189
screen resolution, changing, 194
software upgrade

checking for, 196
failure, 194–195
new version of Ubuntu, 196
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Troubleshooting, system problems, continued
splash screen, disabling, 185
Ubuntu boots into a text interface, 185–186
Ubuntu keeps restarting, 184
Ubuntu logo corrupted, 184–185
Ubuntu won’t start, 183–184
Windows fonts look wrong, 186–187
Word fonts look wrong, 186–187
wrong kernel, 184

Troup, James, 264
TrueType fonts, installing, 187
TSF (The Shuttleworth Foundation), 8
TurboCASH, 421
Tutu, Desmond, 10
Tux Paint, 333–334
Tux Typing, 422
Typing tutor, 332, 422

Ubiquity installer program, 276–277
Ubucons, 257
Ubunteros, 242, 266–267
Ubuntites. See Ubunteros.
Ubuntu

bread recipe, 237–238
characteristics of, 9–10
CoC (Code of Conduct), 20–22
derivatives, 30–31
developer blogs, 71
goals. See Goals of, Ubuntu.
history of. See History of Ubuntu.
KDE desktop environment. See Kubuntu.
LCoC (Leadership Code of Conduct),

398–401
on older, less powerful computers. See

Xubuntu.
for older machines. See Xubuntu.
servers vs. desktops, 23
spin-offs, 30–31
subprojects, 30–31
for use in schools. See Edubuntu.
word origin, 10–11

Ubuntu archive. See also Ubuntu Server,
package management.

APT (Advanced Package Tool) sources,
162–164

apt-cache utility, 165–168
apt-get utility, 165–168
aptitude utility, 170–171
Backports repository, 162
definition, 148–149
downloading packages, 165–168
dpkg utility, 163–164
file owner, finding, 171
file provider, finding, 171–172
installing packages

with apt-get, 167
manually, 164–165

listing owned files, 171
Main repository, 162
malicious packages, 164–165
Multiverse repository, 162
number of packages, 164
official support, 162
package information, displaying, 166–167
removing packages

with apt-get, 167
orphans, 171

repositories, 162–164
Restricted repository, 162
searching, 165–168
searching for packages, 165–168
security, third-party packages, 164–165
standard release support, 162
structure of, 161–162
Universe repository, 162

Ubuntu community. See also Ubuntu
foundation documents.

activists. See Ubunteros.
CoC (Code of Conduct), 20–22
communication venues

announcements, 245
conferences, 256–258
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developer sprints, 254–256
developer summits, 254–256
development discussions. See IRC

(Internet Relay Chat); Mailing lists;
Wikis.

The Fridge, 253–254
general chat. See IRC (Internet Relay

Chat); Mailing lists; Wikis.
IRC (Internet Relay Chat), 246–247
mailing lists, 244–246
overview, 243
Planet Ubuntu blogs, 258–259
sprints, 254–256
summits, 254–256
support-oriented. See IRC (Internet Relay

Chat); Mailing lists; Wikis.
Ubucons, 257
with Ubuntu developers, 249–250
Ubuntu Live conferences, 257
user conferences, 256–258
Web forums, 248–250
wikis, 250–253

description, 242–243
dispute resolution, 263
governance goals, 259–260
governance structures

Community Council, 242, 262–264
LoCos (local community teams), 261
MOTUs (Masters of the Universe),

261–262
SABDFL (self-appointed benevolent

dictator for life), 265–266
team councils, 260–261
teams, 260–261
Technical Board, 264–265
Ubunteros, 266–267
Ubuntu members, 266–267

history of Ubuntu, 17–18
LCoC (Leadership Code of Conduct),

398–401
as a meritocracy, 259

package maintainers, 261–262
package management, 261–262, 265
project technical direction, setting, 

264–265
user involvement

advocacy, 267
artwork, 268–269
documentation, 268
ideas and feedback, 268
packaging, 269–270
programming, 269–270
quality assurance and bugs, 269
support, 267–268
translation and localization, 269

Ubuntu editions. See also Derived distributions;
specific editions.

Edubuntu, 371–372
for educational environments. See

Edubuntu.
for free software. See Gobuntu.
Gobuntu, 373
for KDE (K Desktop Environment). See

Kubuntu.
Kubuntu, 371
for low-power computers. See Xubuntu.
for multimedia production. See Ubuntu

Studio.
Ubuntu Studio, 373–374
for Xfce window management system. See

Xubuntu.
Xubuntu, 372

Ubuntu foundation documents
asking for help, 397
CoC (Code of Conduct), 395–398. See also

LCoC (Leadership Code of Conduct).
collaboration, 396–397
consideration for others, 396
description, 29
dispute resolution, 397
free software, definition, 402
ground rules, 396–398
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Ubuntu foundation documents, continued
LCoC (Leadership Code of Conduct). See also

CoC (Code of Conduct).
conflicts of interest, 400
crediting achievements, 399
delegation, 399
leading by example, 399
overview, 398
personal interests vs. team interests, 400
respecting processes and principles, 399
stepping down, 400–401

licensing
code modifications, 407
default installation, 408
documentation, 407–408
drivers, 407–408
firmware, 407–408
latest version, 405
main component policy, 406–407
redistribution, 406
restricted component, 406–408
royalty payments, 407
software categories, 405–406
software requirements, 406–407

open source, definition, 402
philosophical goals, 18–20
philosophical ideals

core ideals, 401
free software, 402
open source, 402
overview, 401

repository components
main, 403
multiverse, 405
restricted, 404
universe, 404–405

respect for others, 396
stepping down, 397–398

Ubuntu Help Center, 63
#ubuntu IRC channel, 247
Ubuntu Live conferences, 257
Ubuntu members, 266–267

Ubuntu Server
contact information, 180
description, 148–150
GFS (Global File System) support, 150
installing. See Installing Ubuntu Server.
ipvsadm utility support, 150
keepalived utility support, 150
Linux Virtual Server utility support, 150
log files, 176–177
multiprocessor performance, 149
NUMA support, 149
OCFS2 filesystem support, 150
online resources, 180
partitioning, 151–152
Red Hat Cluster Suite support, 150
SMP (symmetric multiprocessing) support,

149
on Sun hardware, 179
for supercomputers, 149

Ubuntu Server, package management. See also
Ubuntu archive.

APT (Advanced Package Tool) sources,
162–164

apt-cache utility, 165–168
apt-get utility, 165–168
aptitude utility, 170–171
Debian package manager, 163–164
distribution upgrades, 168–170

description, 168
do-release-upgrade tool, 168
interrupting, 169
packages, building from source, 169–170
run time, 169
update-manager-core tool, 168

downloading packages, 165–168
dpkg utility, 163–164
file owner, finding, 171
file provider, finding, 171–172
installing packages

with apt-get, 167
manually, 164–165

listing owned files, 171
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malicious packages, 164–165
package information, displaying, 166–167
removing packages

with apt-get, 167
orphans, 171

repositories, 162–164
searching for packages, 165–168
security, third-party packages, 164–165
system updates, with apt-get, 167–168

Ubuntu Server, security
access permissions, 174
device file creation, disabling, 174
file access record, disabling, 175
file execution, disabling, 174
filesystems, 174–175
iptables command, 177–178
networking, 177–178
noatime option, 175
nodev option, 174
noexec option, 174
nosuid option, 174
overview, 172
system log files, 176–177
system resource limits, 175–176
user account administration, 172–174

Ubuntu Studio, 373–374
#ubuntu+1 IRC channel, 247
ubuntu-announce mailing list, 245
#ubuntu-devel IRC channel, 247
ubuntu-devel mailing list, 245
ubuntu-devel-announce mailing list, 245
ubuntu-devel-discuss mailing list, 245
Ubuntulite distribution, 376–377
#ubuntu-offtopic IRC channel, 247
ubuntu-users mailing list, 245, 250
Ukrainian egg bread, 237–238
uname -a command, 388
Universe component, 404–405
Universe repository, 162
Universe repository, 288
Unmounting drives, 131
Update notification, Kubuntu, 293–296

update-manager-core tool, 168
Update-notifier, 285
Updater, 293–296
Updater-Notifier, 293–296
Updating your computer. See Installing updates.
Upgrade notification, disabling, 197
Usability, 66
Usage statistics, 290–291
USB drive access, 305
USB storage devices. See also Disk storage.

buses, listing, 389
copying files to a hard drive, 132
files copied to missing, 215–216
keyring devices, 131–132
LTSP (Linux Terminal Server Project), 352–353
not recognized, 214–215
reads but won’t write, 217–219
USB1 vs. USB2, 132

USB1 vs. USB2, 132
User accounts

adding/removing, 173, 390
adduser command, 173
commands for, 390
configuring, 45–46, 54
deluser command, 173
Edubuntu

groups, 352
setting up, 342

groups
adding/removing, 390
commands for, 390
Edubuntu, 362

hostname, specifying, 46
passwords, 46
security issues, 172–174
username, specifying, 46

User community. See Ubuntu community.
User conferences, 256–258
User files, Ubuntu Server, 151–152
User involvement

advocacy, 267
artwork, 268–269
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User involvement, continued
documentation, 268
ideas and feedback, 268
packaging, 269–270
programming, 269–270
quality assurance and bugs, 269
support, 267–268
translation and localization, 269

Usernames, for new user accounts, 46
Users

adding/removing, 173, 233
logged on, displaying, 390

/usr folder, 107
UTC (Coordinated Universal Time), 341–342

/var folder, 107
/var partition, 151–152
Vector drawing, 422
Vendor lockup, 74
Verisign, 8
Version control, 27
Version information, printing, 388
Vertical bar (|), pipe symbol, 140, 393
VGs (volume groups), 158
Video

DVD encryption, 117
Ekiga, 90–93
Movie Player, 97
Totem, 115–116
Totem Movie Player, 420
watching, 97, 115–117

Virtual computer. See Dual boot.
Visio, 422
Visual themes and backgrounds. See Back-

ground, desktop; Themes.
VMWare client crashes while booting, 364
VOIP (Voice Over IP)

Ekiga, 8
Ubuntu/Windows equivalents, 421

Volkerding, Patrick, 14
Voyager III, 422

The Warthogs, 2–3, 9–10
Warty Warthog, 148
Wastebasket. See Trash.
Watching video, 97, 115–117
Weather, monitoring, 237
Web browsers. See also Firefox; Konqueror.

Galeon, 227
Konqueror, 308–309
lightweight alternative, 227
Ubuntu/Windows equivalents, 420

Web editor, 100–101
Web forums

CoC (Code of Conduct), 398
Edubuntu, 366
Kubuntu, 321
Ubuntu community, 248–250

Web pages
bookmarking, 70–71
browsing. See Firefox; Konqueror.
failure to load, 207
previewing, 71
tabbed browsing, 70

Web sites, Edubuntu related, 365
Webcam, Ekiga, 93, 95
Webmail, 75
who command, 390
Widgets, 283
Wikis, 250–253, 321
Wildcards, 392
Winamp, 420
Window behavior, Kubuntu, 297
Window Behavior section, System Settings

window, 297
Window manager alternatives, 355–356
Windows

emulation, Kubuntu. See Wine.
fonts look wrong, 186–187
open source programs for, 377
partition access, 233
partition access, Kubuntu, 305–306
partitions, sharing with Ubuntu, 45
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running Ubuntu programs on, 377
Ubuntu compatibility

accessing Windows files, 144–145
running applications, 144
Wine project, 144

Windows Media Player, 420
Windows programs, Ubuntu equivalents

3D modeling, 422
Abiword, 419
Access, 420
accounting, 421
AIM, 421
astronomy, 422
Banshee, 420
Base, 420
Beep Media Player, 420
Blender, 422
Calc, 419
Celestia, 422
databases, 420
desktop publishing, 421
Dia, 422
diagram editing, 422
drawing, 422
education, 422
edutainment, 422
Ekiga Softphone, 421
email, 420
Epiphany, 420
Evolution, 420
Excel, 419
finance, 421–422
Firefox, 420
Flight Simulator, 422
flight simulator, 422
FlightGear, 422
games, 422
GIMP, 420
GizmoProject, 421
Glom, 420
Gnucash, 421

Gnumeric, 419
Grisbi, 421
ICQ, 421
Illustrator, 422
Impress, 419
Inkscape, 422
instant messaging, 421
Internet Explorer, 420
iTunes, 420
KTouch, 422
Mavis Beacon Teaches Typing, 422
Maya, 422
media players, 420
modeling, 422
Money, 421
Muine, 420
office, 421–422
Orbiter, 422
Outlook, 420
Outlook Express, 420
personal accounting, 421
photo editors, 420
Photoshop, 420
Pidgin, 421
planetarium, 422
Planner, 422
PowerPoint, 419
presentation software, 419
Project, 422
project management, 422
Publisher, 421
Quickbooks, 421
Quicken, 421
Rhythmbox, 420
Scribus, 421
Skype, 421
space simulator, 422
spreadsheet, 419
Starry Night, 422
Stellarium, 422
Thunderbird, 420
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